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GIỚI THIỆU 

CẨM NANG HƯỚNG DẪN TỔ CHỨC ĐÀO TẠO TRỰC TUYẾN 

TRONG GIÁO DỤC NGHỀ NGHIỆP 

Sự ảnh hưởng của cuộc cách mạng công nghệ 4.0 đã tác động đến mọi lĩnh vực 

kinh tế – xã hội, đồng thời thay đổi hoàn toàn hệ thống sản xuất và quản trị hiện nay. 

Cùng với sự phát triển mạnh mẽ của công nghệ thông tin và truyền thông, đào tạo trực 

tuyến (E-learning) ra đời như một cuộc cách mạng về dạy và học, trở thành một xu thế 

tất yếu của thời đại và đang “bùng nổ” ở nhiều nước đã và đang phát triển, nhất là trong 

bối cảnh đại dịch COVID-19 đang tác động mạnh mẽ đến toàn thế giới.  

Nền kinh tế thế giới đang bước vào giai đoạn kinh tế tri thức. Đặc điểm của nền 

kinh tế này là dịch vụ sẽ là khu vực thu hút được nhiều lao động tham gia nhất và là 

những lao động có tri thức cao. Do đó việc nâng cao hiệu quả chất lượng giáo dục, đào 

tạo sẽ là nhân tố sống còn quyết định sự tồn tại và phát triển của mỗi quốc gia, công 

ty, gia đình, và cá nhân. E-learning chính là một giải pháp hữu hiệu giải quyết vấn đề 

này. Việc học tập không chỉ bó gọn trong việc học phổ thông, học đại học mà cả giáo 

dục nghề nghiệp (GDNN), một cấp học chú trọng vào đào tạo kỹ năng. 

Đào tạo trực tuyến là phương thức học thông qua một máy tính, hoặc thiết bị di 

động nối mạng đối với một máy chủ ở nơi khác có lưu giữ sẵn bài giảng điện tử và 

phần mềm cần thiết để có thể yêu cầu cho học sinh học trực tuyến từ xa. Giáo viên có 

thể truyền tải hình ảnh và âm thanh qua đường truyền băng thông rộng hoặc kết nối 

không dây (WiFi, WiMAX), mạng nội bộ (LAN). 

Đào tạo trực tuyến cho phép đào tạo mọi lúc mọi nơi, truyền đạt kiến thức theo 

yêu cầu, thông tin đáp ứng nhanh chóng. Học viên có thể truy cập các bài học, các 

khoá học bất kỳ nơi đâu như tại văn phòng làm việc, tại nhà, tại những điểm Internet 

công cộng, 24 giờ một ngày, 7 ngày trong tuần.  

Ưu điểm của đào tạo trực tuyến giúp giảm khoảng 60% các chi phí truyền thống 

như địa điểm, lớp học, giáo viên....; giúp giảm thời gian đào tạo từ 20-40% so với 

phương pháp giảng dạy truyền thống nhờ hạn chế sự phân tán và thời gian đi lại; học 

viên có thể chọn lựa những khoá học có sự chỉ dẫn của giảng viên trực tuyến hoặc 

khoá học tự tương tác (Interactive Self-pace Course), tự điều chỉnh tốc độ học theo khả 

năng và có thể nâng cao kiến thức thông qua những thư viện trực tuyến; nội dung 

truyền tải nhất quán. Đào tạo trực tuyến dễ dàng tạo và cho phép học viên tham gia 

học, dễ dàng theo dõi tiến độ học tập, và kết quả học tập của học viên. 

Từ những tháng đầu năm 2020, đại dịch COVID-19 bùng phát mạnh mẽ trên thế 

giới, diễn biến phức tạp, gây khó khăn cho hệ thống giáo dục đào tạo nói chung, hệ 

thống giáo dục nghề nghiệp (GDNN) nói riêng. Để ứng phó với tình hình mới, dưới sự 

chỉ đạo của lãnh đạo Bộ Lao động - Thương binh và Xã hội, lãnh đạo Tổng cục Giáo 

dục nghề nghiệp, hệ thống GDNN đã chuyển đổi tuyển sinh, đào tạo từ truyền thống 

(offline) sang hình thức đào tạo trực tuyến (online).  

https://vi.wikipedia.org/wiki/H%E1%BB%8Dc_sinh
https://vi.wikipedia.org/wiki/Tr%E1%BB%B1c_tuy%E1%BA%BFn
https://vi.wikipedia.org/wiki/Gi%C3%A1o_vi%C3%AAn
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Đào tạo trực tuyến tuy có nhiều ưu điểm song lại là vấn đề quá mới mẻ với hệ 

thống GDNN, một hệ thống với đặc trưng là đào tạo thực hành, phát triển kỹ năng. Các 

cơ sở GDNN trước đây hầu hết chỉ quen với việc tổ chức đào tạo trực tiếp, gắn với việc 

hướng dẫn thực hành, thực tập trực tiếp nay chuyển sang đào tạo trực tuyến, giảng 

dạy, hướng dẫn từ xa; trình độ, kinh nghiệm, kỹ năng ứng dụng CNTT trong dạy học của 

nhà giáo ở nhiều cơ sở GDNN cũng còn hạn chế.... Về mặt pháp lý, mặc dù đã có một 

số quy định cho việc đào tạo trực tuyến nhưng những quy định này chưa tính hết 

những phát sinh mới trong thực tiễn.v.v... Những điều đó dẫn đến việc tổ chức đào tạo 

trực tuyến trong GDNN gặp không ít khó khăn. 

Để góp phần vào giải quyết những khó khăn nêu trên, được sự đồng ý của lãnh 

đạo Tổng cục Giáo dục nghề nghiệp, sự giúp đỡ của Chương trình hợp tác Việt Đức về 

Đổi mới đào tạo nghề tại Việt Nam do Cơ quan Hợp tác Phát triển Đức (GIZ) thay mặt 

Bộ kinh tế và hợp tác phát triển Đức thực hiện, Vụ Đào tạo chính quy, Tổng cục Giáo 

dục nghề nghiệp đã chủ trì tổ chức biên soạn tài liệu điện tử: “Cẩm nang đào tạo trực 

tuyến trong giáo dục nghề nghiệp”. 

“Cẩm nang đào tạo trực tuyến trong giáo dục nghề nghiệp” là tài liệu hướng dẫn 

đầy đủ, chi tiết các nội dung liên quan đến việc tổ chức đào tạo trực tuyến tại các cơ sở 

GDNN, giúp các nhà giáo, các nhà trường có thêm thông tin, kiến thức, kỹ năng về tổ 

chức quản lý, đào tạo trực tuyến. Cuốn Cẩm nang bao gồm các nội dung chính sau: 

1. Khái quát về elearning 

2. Quy định và hướng dẫn về đào tạo trực tuyến; 

3. Hướng dẫn sử dụng các phần mềm đào tạo trực tuyến  

4. Hướng dẫn xây dựng hệ LMS bằng mã nguồn mở 

5. Phụ lục: Một số văn bản hướng dẫn đào tạo trực tuyến. 

“Cẩm nang đào tạo trực tuyến trong giáo dục nghề nghiệp” được phát hành trên 

nền tảng web tại địa chỉ: http://daotaocq.gdnn.gov.vn/, và có phiên bản điện tử phát 

hành trên website của Vụ Đào tạo chính quy, Tổng cục Giáo dục nghề nghiệp. Qua đây, 

Ban Biên tập xin được cảm ơn Chương trình hợp tác Việt Đức về Đổi mới đào tạo nghề 

tại Việt Nam, Tập đoàn Giáo dục và Công nghệ thông tin (IEG) và các chuyên gia của 

nhiều doanh nghiệp, cơ sở đào tạo công nghệ thông tin đã hỗ trợ trong quá trình xây 

dựng Cẩm nang. 

Do nguồn lực và thời gian có hạn, “Cẩm nang đào tạo trực tuyến trong giáo dục 

nghề nghiệp” có thể còn có những thiếu sót, Ban Biên tập rất mong nhận được sự góp ý 

của các cơ sở GDNN, các chuyên gia, các nhà giáo để hoàn thiện cho lần xuất bản 

sau./. 

 

 BAN BIÊN TẬP 

  

http://daotaocq.gdnn.gov.vn/
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PHẦN THỨ NHẤT 

KHÁI QUÁT CHUNG VỀ ĐÀO TẠO TRỰC TUYẾN 

TRONG GIÁO DỤC NGHỀ NGHIỆP 

 1. Khái niệm đào tạo trực tuyến 

E-learning là một phương thức đào tạo hiện đại dựa trên công nghệ thông tin. Với 

sự bùng nổ phát triển của công nghệ hiện nay, E-learning ngày càng được ưa chuộng 

bởi tính linh hoạt và tiện dụng về thời gian lẫn địa điểm. 

Có nhiều quan điểm, định nghĩa khác nhau về e-Learning, dưới đây sẽ một số 

những khái niệm e-Learning đặc trưng nhất. 

- E-Learning là sử dụng các công nghệ Web và Internet trong học tập (William 

Horton); 

- E-Learning là một thuật ngữ dùng để mô tả việc học tập, đào tạo dựa trên công 

nghệ thông tin và truyền thông (Compare Infobase Inc); 

- E-Learning nghĩa là việc học tập hay đào tạo được chuẩn bị, truyền tải hoặc 

quản lý sử dụng nhiều công cụ của công nghệ thông tin, truyền thông khác nhau và 

được thực hiện ở mức cục bộ hay toàn cục (MASIE Center); 

- Việc học tập được truyền tải hoặc hỗ trợ qua công nghệ điện tử. Việc truyền tải 

qua nhiều kĩ thuật khác nhau như Internet, TV, video tape, các hệ thống giảng dạy 

thông minh, và việc đào tạo dựa trên máy tính (CBT) (Sun Microsystems, Inc); 

- Việc truyền tải các hoạt động, quá trình, và sự kiện đào tạo và học tập thông qua 

các phương tiện điện tử như Internet, intranet, extranet, CD-ROM, video tape, DVD, TV, 

các thiết bị cá nhân... (e-learningsite); 

- "Việc sử dụng công nghệ để tạo ra, đưa các dữ liệu có giá trị, thông tin, học tập 

và kiến thức với mục đích nâng cao hoạt động của tổ chức và phát triển khả năng cá 

nhân." (Định nghĩa của Lance Dublin, hướng tới e-learning trong doanh nghiệp); 

- UNESCO xác dịnh, ÐTTT là quá trình học tập sử dụng các phuong tiện điện tử, 

CNTT và truyền thông. Ðào tạo trực tuyến cho phép mọi người có thể học ở mọi lúc, 

mọi nơi, xóa bỏ những giới hạn về thời gian và không gian để cho mọi nguời có cơ hội 

học tập và học tập theo nhu cầu của mình (UNESCO, 2010) [99].  

- Theo tác giả Tony Bates, tất cả các hoạt dộng trên máy tính và Internet hỗ trợ 

giảng dạy và học tập, cả trong trường và ở xa, bao gồm cả việc sử dụng các CNTT và 

truyền thông về hành chính cũng như khoa học để hỗ trợ học tập, như phần mềm liên 

kết giữa cơ sở dữ liệu của sinh viên và việc giảng dạy, ví dụ nhu danh sách lớp học, địa 

chỉ e-mail, v.v. Ngoài ra, ÐTTT có các hình thức khác nhau, từ trợ giúp lớp học đến học 

tập trực tuyến hoàn toàn.  

Có thể nói rằng, khái niệm và nội hàm ÐTTT được rất nhiều tác giả đề cập, nhìn 

chung đều có những điểm chung xoay quanh việc học tập dựa trên CNTT cùng với mối 

liên hệ giữa nguời dạy, nguời học thông qua các hoạt động dạy học, nội dung, phương 
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pháp giảng dạy. Như vậy, có thể hiểu, ÐTTT là quá trình đào tạo sử dụng các phương 

tiện điện tử, CNTT và truyền thông nhằm thực hiện chuyển giao, chia sẻ kiến thức giữa 

nguời dạy và nguời học, xóa bỏ những giới hạn về thời gian và không gian. 

 2. So sánh đào tạo trực tuyến với đào tạo truyền thống 

Đào tạo trực tuyến có nhiều ưu điểm như: Không bị giới hạn bởi không gian và 

thời gian nhờ có sự phổ cập rộng rãi của Internet, do dó có thể giúp cho nguời học tiết 

kiệm thời gian; Tính hấp dẫn cao: Với sự hỗ trợ của công nghệ multimedia, những bài 

giảng được tích hợp dạng văn bản với các dạng hình ảnh, âm thanh, video… nguời học 

có thể tương tác với bài học; Tính dễ tiếp cận, truy cập ngẫu nhiên cho phép học viên 

lựa chọn đơn vị tri thức, tài liệu một cách tùy ý theo trình độ kiến thức và điều kiện truy 

nhập mạng của mình; Tính cập nhật: nội dung khóa học thuờng xuyên được cập nhật 

và đổi mới để đáp ứng nhu cầu nguời học; Có sự hợp tác, trao dổi giữa các học viên với 

nhau và giữa học viên với giáo viên. Có thể tổng hợp những ưu điểm của đào tạo trực 

tuyến và so sánh với đào tạo truyền thống như Bảng sau (Bảng 1): 

Bảng 1: So sánh giữa đào tạo truyền thống và đào tạo trực tuyến 

Yếu tố Đào tạo truyền thống Đào tạo trực tuyến 

Lớp học - Phòng học, kích thước không 
gian giới hạn. 

- Phải có đủ một số lượng 
người học nhất định mới mở 
được lớp học. 

- Thụ động, học đồng bộ & chỉ 
có thể học tập trung một chỗ. 

 

- Không giới hạn không gian, thời gian. 

- Hầu như không có khái niệm lớp học, 
một người đăng ký vào 1 môn học vẫn 
học bình thường. 

- Trường hợp muốn mở 1 lớp học theo 1 
môn học nào đó vẫn tổ chức được. 

- Dễ tiếp cận, linh hoạt, 

- Chủ động học mọi lúc, mọi nơi 

- Tự định hướng 

- Có thể triển khai Offline, Online. 

Nội dung  - Powerpoint, máy chiếu; 

- Sách giáo khoa, thư viện; 

- Video; 

- Tính tự học chưa được khai 
thác tối đa; 

- Nội dung không phong phú, 
hạn chế, tiếp cận với kiến 
thức mới chậm trễ. 

 

- Đa phương tiện, mô phỏng; 

- Thư viện số; 

- Theo yêu cầu; 

- Truyền thông đồng bộ hay không đồng 
bộ; 

- Khai thác, phát huy tối đa khả năng tự 
học và tính sáng tạo của người học; 

- Nội dung phong phú, dễ tiếp cận với 
các kiến thức, công nghệ khoa học kỹ 
thuật mới. 
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Yếu tố Đào tạo truyền thống Đào tạo trực tuyến 

Giao tiếp, 
truyền thông 

- Hợp tác, trao đổi trực tiếp 
tần số ít do sự e ngại của 
người học; 

- Chủ đề giao tiếp giới hạn, số 
lượng người tham gia hạn 
chế, chỉ thực hiện từng nhóm 
nhỏ; 

- Phân phối, thu nhận thông 
tin chậm. 

- Hợp tác, trao đổi với tần số cao giữa: 
Giảng viên – Người học; Người học – 
Người học vì không phụ thuộc sự e ngại 
do mặt đối mặt; 

- Chủ đề giao tiếp đa dạng, không giới 
hạn số người tham gia thảo luận 1 chủ 
để hay nhiều chủ đề. Giảng viên hoàn 
toàn kiểm soát được diễn biến của các 
nội dung thảo luận.  

- Phân phối, thu nhận thông tin nhanh 
thông qua các hình thức: Chat; Email; 
Diễn đàn (forum)… 

Thời gian - Giảng viên, người học phải 
theo tiến độ chung tổ chức 
của lớp học; 

- Tốn thời gian, gò bó về mặt 
thời gian. 

- Linh hoạt cho cả Giảng viên & người học, 
có thể tự điều chỉnh. 

- Tiết kiệm thời gian, tranh thủ được thời 
gian chết. 

Thi, kiểm tra 
chuẩn hóa 
kiến thức 

- Tốn kém giấy tờ 

- Mất nhiều thời gian chấm bài 

- Hệ thống tự động chấm bài và đưa ra 
kết quả. 

Chi phí - Chi phí tổ chức, quản lý tốn 
kém 

- Chi phí in ấn, phân phối tài 
liệu tốn kém cho cả người dạy, 
người học 

- Chi phí tổ chức, quản lý thấp 

- Hầu như không có chi phí cho việc in ấn 
tài liệu. 

- Tiết kiệm chi phí đi lại, ăn ở cho người 
dạy, người học. 

Luyện tập, 
thực hành, tự 
đánh giá 

- Kỹ năng thực hành được 
luyện tập tốt hơn khi tập trung; 

- Giới hạn về số luợng bài tập; 

- Bài tập tự đánh giá của học 
viên phụ thuộc vào sự phản 
hồi của giảng viên nhanh hay 
chậm.  

- Kỹ năng thực hành khó đáp ứng tốt như 
khi tập trung; 

- Hệ thống câu hỏi trắc nghiệm cho phép 
không giới hạn số luợng bài tập; 

- Hỗ trợ phản hồi ngay kết quả tự động 
trên hệ thống công nghệ.  

 3. Một số hình thức đào tạo trực tuyến 

Như đã trình bày ở trên, ÐTTT là quá trình đào tạo sử dụng các phương tiện điện 

tử, CNTT và truyền thông. Ðó là một cách hiểu chung nhất, tuy nhiên tùy theo cách 

thức, mức độ ứng dụng CNTT mà việc áp dụng ÐTTT cũng có nhiều hình thức khác 

nhau.  
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- Ðào tạo trực tiếp theo cách truyền thống: Trong khi sinh viên có thể tham dự các 

bài giảng trực tiếp trên lớp, hiện nay việc sử dụng công nghệ để cung cấp thêm các 

nguồn tài nguyên đào tạo và/hoặc các công cụ quản lý đã trở thành một chuẩn mực; 

- Ðào tạo hoàn toàn trực tuyến: Ðào tạo hoàn toàn trực tuyến có thể biểu hiện 

dưới nhiều hình thức. Ðuợc biết đến nhiều nhất là các khóa học mở trực tuyến đại 

chúng (MOOCs – Massive Open Online Courses). Ở nhiều cơ sở đào tạo hiện nay, các 

chuong trình học được cung cấp hoàn toàn trực tuyến mà không yêu cầu người học 

phải đến lớp học tại giảng đường. Tài nguyên học tập được cung cấp trực tuyến, các 

hoạt động tương tác, liên lạc và đánh giá diễn ra thông qua một hệ thống quản lý học 

tập hoặc các nền tảng công nghệ - kỹ thuật khác; 

- Ðào tạo hỗn hợp: Là phương thức phổ biến nhất của ÐTTT trong bối cảnh giáo 

dục đào tạo trên thế giới hiện nay, nhất là bối cảnh của dịch bệnh COVID-19. Sinh viên 

có thể tham dự một số lớp học trực tiếp/trực diện, nhưng đồng thời cũng truy cập tài 

nguyên, tương tác với giảng viên và với nhau, tham gia các hoạt động học tập trong 

môi truờng trực tuyến. Là một phần của một chương trình học tập hỗn hợp, một số 

môn học có thể kết hợp các hoạt động trực tuyến với việc học tập và đánh giá trực 

tiếp. Ví dụ, sinh viên có thể được yêu cầu xem truớc một phần nội dung bài giảng, hoàn 

thành các bài tập kiểm tra trực tuyến, các hoạt động mô phỏng để chuẩn bị cho các 

buổi hướng dẫn hoặc các buổi thực hành tại phòng thí nghiệm được tổ chức trên lớp. 

Tuy nhiên bên cạnh đó, một số học phần trong chương trình học tập hỗn hợp có thể 

được cung cấp hoàn toàn trực tuyến (Hình 1) 

 

Hình 1. Cấu trúc chương trình đào tạo hỗn hợp 

(Nguồn: Theo tài liệu nghiên cứu về “Ðảm bảo chất lượng trong đào tạo trực tuyến” 

của Trung tâm nghiên cứu giáo dục Đại học Melbourne tại Trường Đại học Melbourne) 

 4. Các mức độ trong đào tạo trực tuyến 

- Xét theo mức độ tác dộng của CNTT và truyền thông đến các hoạt động học tập, 

đào tạo trực tuyến được chia thành 5 mức độ sau: 

+ Mức 1: ÐTTT phụ trợ trực diện. Tỷ lệ các hoạt động học tập được kết nối với 

Internet là 0% -10%, ÐTTT chỉ là phụ trợ; 
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+ Mức 2: ÐTTT bổ trợ trực diện. Tỷ lệ các hoạt động học tập được kết nối với 

Internet là 11% - 39%, học tập có sự hỗ trợ trực tuyến; 

+ Mức 3: ÐTTT ngang bằng trực diện. Tỷ lệ các hoạt động học tập được kết nối 

với Internet là 40% - 59%, học tập kết hợp giữa trực diện và ÐTTT; 

+ Mức 4: Trực diện bổ trợ ÐTTT. Tỷ lệ các hoạt động học tập được kết nối với 

Internet là 60% - 89%, học tập có sự bổ trợ đắc lực của trực tuyến; 

+ Mức 5: ÐTTT hoàn toàn chủ đạo với tỷ lệ kết nối với Internet là 90% - 100%. Học 

tập hoàn toàn dựa vào công nghệ tử và số hóa.  

Hình 2. Mô hình tổ chức ĐTTT dựa trên tác động của  

CNTT và truyền thông 

 

- Xét về mặt hệ thống, ÐTTT được tổ chức thành 3 cấp độ:  

+ Cấp độ 1: Trực tuyến - CBT (Computer-Based Training - Học trên máy tính) & 

WBT (Web-Based Training - Học trên Web/Internet/Intranet), là khởi đầu của mọi mô 

hình ĐTTT. Học viên học thông qua Web và các học liệu điện tử cho phép học từng 

bước, có kiểm tra mức độ tiếp thu bài, học viên tự học, không có giáo viên hướng dẫn, 

chi phí thấp; 

+ Cấp độ 2: Trực tuyến kết hợp: Học trực tuyến có giảng viên, thông qua 

Internet/Intranet, theo đó người dạy và người học cùng có mặt vào thời điểm; có sự 

tương tác. Giảng viên có thể trực tiếp trả lời câu hỏi, đặt câu hỏi, chấm điểm đánh giá 

học viên, có thể chỉ dẫn học viên tham gia các khóa học mức cao hơn; sử dụng hệ 

thống quản lý học tập LMS. 

+ Cấp độ 3: Lớp học ảo, học thông qua mạng Internet/Intranet, sử dụng Hệ 

thống Quản lý Học tập (LMS). Các “lớp học ảo” được tổ chức ngay trên 

mạng như các lớp học thông thường. Các giờ học “live” được tổ chức để 

thảo luận về các “tình huống (case studies)”. Giáo viên có thể thực hiện các hướng dẫn 

trực tiếp (hands-on) nhờ công nghệ Streaming: VOD, Elap, econnect, wiziq… Sinh viên 

có thể học trực tiếp hoặc xem lại các bài giảng và làm bài tập off-line với hình thức 

giống như đang tham gia lớp học trực tiếp. Tất cả các khoá học trực tuyến có thể được 
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quản lý, giám sát giống như các lớp học thông thườngCác mức phân loại duợc dua ra 

theo tiêu chí dựa trên việc phân phối nội dung 

 5. Vai trò và ảnh hưởng của ĐTTT trong giáo dục nghề nghiệp 

Ðào tạo trực tuyến ngày càng trở nên quan trọng và đang dần làm thay đổi mô 

hình học tập, cách thức tiếp cận tri thức của nhiều đối tuợng tiềm năng như học sinh, 

sinh viên, viên chức nhà nuớc... trong giai doạn hiện nay. ÐTTT đang làm cho việc học 

tập trở nên thú vị hơn, hấp dẫn hơn và thuyết phục hơn. 

* Vai trò chung 

- Là chất xúc tác dang làm thay dổi toàn bộ mô hình học tập trong thế kỷ này. Mọi 

nguời không phân biệt tuổi tác, không phụ thuộc vào khoảng cách địa lý đều có thể 

tham gia học tập. ÐTTT giúp cho việc học tập dạng thụ động nhu truớc đây được giảm 

bớt. Nguời học không cần phải tập trung trong các lớp học với kiểu học “đọc và ghi” 

thông thuờng, giúp cho việc học tập trở nên rất chủ động. Ðiều cốt yếu là tập trung vào 

sự tương tác, “học di dôi với hành”. Nguời học có thể vừa xem các bài giảng động bằng 

flash vừa có thể thực hành theo ngay trên máy; 

- Giúp cho việc học tập trở nên thú vị hon, hấp dẫn hơn và thuyết phục hơn. Các 

môn học khó hoặc nhàm chán có thể trở nên dễ dàng hon, thú vị hơn; 

- Có thể hỗ trợ “học tập thông qua nhận xét và thảo luận” dựa trên cộng đồng trực 

tuyến.  

- Cho phép nguời học tự quản lí đuợc tiến trình học tập của mình theo cách phù 

hợp nhất. Có nhiều cách học khác nhau như đọc, xem, khám phá, tìm hiểu, tuong tác, 

thực hành, giao tiếp, thảo luận, chia sẻ kiến thức. ÐTTT đồng nghĩa với việc nguời học 

có thể truy cập tới rất nhiều nguồn tài nguyên phục vụ cho học tập: cả tư liệu và con 

người, và theo cách này mỗi nguời đều có quyền chọn lựa hình thức học tập phù hợp 

nhất với khả năng và điều kiện của mình; 

- ÐTTT có thể loại bỏ các rào cản về thời gian và không gian, là những rào cản có 

thể khiến sinh viên không thể tham gia vào các chương trình học tập truyền thống tại 

nhà truờng. Giúp cho việc học tập vẫn có thể tiến hành được đồng thời trong khi làm 

việc, khi mà các doanh nghiệp đã bắt đầu nhận thấy học tập không chỉ có thể diễn ra 

lớp học. Nguời học không còn phải đi những quãng đường dài để theo học một khóa 

học dạng truyền thống, nguời học hoàn toàn có thể học tập bất cứ khi nào họ muốn, 

ban ngày hay ban đêm, tại bất cứ đâu - tại nhà, tại công sở, tại thư viện nội bộ.  

- ĐTTT đã làm thay đổi cách dạy và học theo các tiêu chí mới như: Học mọi nơi 

(any where), học mọi lúc (any time), học suốt đời (life long), dạy cho mọi nguời (any 

one) và mọi trình độ tiếp thu khác nhau.  

* Vai trò của ĐTTT đối với người học 

- Làm biến đổi cách học cũng như vai trò của nguời học, nguời học đóng vai trò 

trung tâm và chủ động của quá trình chiếm linh tri thức của mình. ÐTTT phù hợp với 

nhiều đối tuợng học tập, mỗi nguời học có phong cách học tập, cách tiếp cận nguồn tri 

thức khác nhau, nguời học có thể học theo thời gian biểu cá nhân, với tốc độ tuỳ theo 
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khả năng và có thể chọn các nội dung học phù hợp, do đó nó sẽ mở rộng đối tuợng 

đào tạo rất nhiều; 

- Tạo ra sự hấp dẫn với nhiều đối tuợng người học. Với người học phổ thông sẽ 

được lôi cuốn bởi các bài giảng đa phương tiện với âm thanh, hình ảnh sống động, kỹ 

xảo hoạt hình, các trò chơi mang tính giáo dục cao, các bài học mô phỏng: Phòng thí 

nghiệm ảo, thư viện ảo,… có độ tương tác cao giữa nguời học và chương trình, đàm 

thoại trực tiếp qua mạng. Ðiều này đem đến cho học viên sự thú vị, say mê trong quá 

trình tiếp thu kiến thức cũng nhu hiệu quả trong học tập. Với người trưởng thành, họ 

luôn thấy thuận tiện, hấp dẫn bởi thời gian linh hoạt và phù hợp với hoàn cảnh công 

việc, chi phí đầu tư cho việc học tập, nghiên cứu thấp và đặc biệt là họ được lựa chọn 

những kiến thức cần thiết dể phục vụ cho công việc hiện tại một cách thuận lợi và 

nhanh chóng.  

- Cho phép nguời học làm chủ hoàn toàn quá trình học của bản thân, từ thời gian, 

lượng kiến thức cần học cũng như thứ tự học các bài, đặc biệt là cho phép tra cứu trực 

tuyến những kiến thức có liên quan đến bài học một cách tức thời, duyệt lại những 

phần đã học một cách nhanh chóng, tự do trao đổi với bạn bè hoặc giáo viên ngay 

trong quá trình học.  

* Vai trò của đào tạo trực tuyến đối với các nhà giáo dục: 

- Thúc đẩy một nền giáo dục mở, giúp mọi nguời tiếp cận rất nhiều thông tin, 

thông tin nhiều chiều, rất nhanh, rút ngắn mọi khoảng cách, thu hẹp mọi không gian, 

tiết kiệm về thời gian. Do thông tin nhiều chiều nên hoạt động giáo dục tất yếu phải dân 

chủ hơn, hạn chế áp đặt một chiều, tự do tư tuởng tốt hơn đối với nguời học, nhờ vậy, 

tư duy độc lập phát triển, dẫn đến năng lực phát triển.  

- Giúp cho việc đổi mới nền giáo dục toàn diện, chuyển nền giáo dục từ chủ yếu là 

truyền thụ kiến thức sang phát triển nang lực nguời học, giảm thuyết giảng, tăng tự 

học, thực hiện “giảng ít, học nhiều”, bằng cách giúp nguời học phương pháp tiếp cận và 

cách tự học, cách giải quyết vấn đề. Việc truyền thụ, cung cấp kiến thức sẽ do CNTT 

đảm nhận, giải phóng nguời thầy khỏi sự thiếu hụt thời gian, để nguời thầy có thể tập 

trung giúp nguời học phương pháp tiếp cận và giải quyết vấn đề, tổ chức các hoạt dộng 

học tập gắn với thực tiễn nhằm phát triển năng lực của nguời học.  

- Giúp nâng cao chất lượng và hiệu quả công việc giảng dạy. Chất luợng giáo dục 

phụ thuộc rất nhiều vào năng lực của người thầy, một nguời thầy giỏi có thể thay thế 

nhiều người thầy không giỏi, tiếp cận cùng lúc với nhiều nguời học ở nhiều nơi, bất kể 

khoảng cách xa, gần. Giúp xóa bỏ ranh giới địa lý, trình độ, văn hóa vùng miền, tuổi tác, 

thậm chí cả ngôn ngữ,… góp phần tạo ra xã hội học tập và học tập suốt dời.  

* Vai trò của đào tạo trực tuyến đối với các nhà quản trị giáo dục: 

- Hệ thống ÐTTT là một giải pháp đào tạo đồng bộ, giúp cho công việc quản lý 

đầy đủ hơn, khoa học hơn, minh bạch và dân chủ hơn, từ quản lý nguời học, nguồn 

nhân lực, chương trình, kế hoạch đào tạo, tài nguyên học tập cho dến tài chính, một 

cách đồng bộ và tối ưu hóa phương án quản lý. Hệ thống ÐTTT giúp cho việc kiểm tra, 
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đánh giá năng lực nguời học, năng lực của các cơ sở đào tạo một cách công bằng và 

minh bạch, từ đó, giúp cho nhà quản trị giáo dục có giải pháp hỗ trợ kịp thời, phát huy 

và nâng cao chất luợng, hiệu quả tại các cơ sở GDNN 

- Với cuộc CMCN 4.0, truờng học sẽ không là nơi độc quyền trong việc tạo và 

chuyển giao tri thức. Mô hình “nhà truờng - doanh nghiệp” sẽ là công bằng và pha trộn 

khi xem xét ở góc độ chuyển giao các sản phẩm tri thức “lý thuyết đi đôi với thực tiễn”. 

Vì vậy, ÐTTT sẽ giúp các nhà quản trị giáo dục địa phương định hướng, phát triển 

nguồn nhân lực để tạo ra các sản phẩm tri thức phù hợp với sự phát triển kinh tế xã hội 

tại địa phương. 

Ngoài ra, theo bộ tài liệu nghiên cứu về “Ðảm bảo chất luợng trong đào tạo trực 

tuyến” của Trung tâm nghiên cứu giáo dục dại học Melbourne tại truờng đại học 

Melbourne[38], ÐTTT có thể loại bỏ các rào cản về thời gian và không gian, là những 

rào cản có thể khiến sinh viên không thể tham gia vào các chương trình học tập truyền 

thống tại nhà trường. Những tiến bộ về công nghệ và phương pháp giảng dạy gần đây 

đồng nghia với việc các chương trình ÐTTT có thể cung cấp những trải nghiệm hấp 

dẫn, chất luợng cao cho người học - thậm chí ngay cả với các chương trình như kỹ 

thuật và y học, vốn thuờng được coi là mang nặng tính “thực hành”.  

Như vậy, có thể nói rằng đào tạo trực tuyến có vai trò đáp ứng mọi nhu cầu học 

tập, đặc biệt có vai trò quan trọng trong việc xây dựng xã hội học tập và học suốt đời.  

 6. Một số hạn chế của đào tạo trực tuyến 

* Về những hạn chế chung 

GDNN với đặc trưng cơ bản là đào tạo để hình thành kỹ năng cho người học. 

Phương pháp giảng dạy chủ yếu là phương pháp dạy học thực hành, việc học chủ yếu 

là thông qua luyện tập. Do vậy, ĐTTT khó có thể đáp ứng được việc hình thành kỹ năng, 

nhất là các kỹ năng nghề nghiệp chuyên sâu ở các nghề kỹ thuật, công nghệ. 

* Về phía người học 

- Sự giãn cách của người học: Người học theo ĐTTT có thể ở xa chịu sự giãn cách 

về mặt địa lý với nhà truờng, với giảng viên và với các sinh viên khác. Hơn nữa việc học 

từ xa tại nhiều địa diểm học tập khác nhau như cơ quan, nơi công cộng sẽ ảnh huởng 

dến việc tập trung. Học từ xa còn hạn chế cơ hội giao tiếp đối thoại trong học tập.  

- Nhu cầu cá nhân của người học: Người học từ xa có nhiều hoàn cảnh và điều 

kiện khác nhau, ở nhiều nơi khác nhau, có nghề nghiệp riêng và có nhiều độ tuổi. Vì vậy, 

nhu cầu học tập của họ không như nhau và giáo dục từ xa mang đến cho họ có sự chi 

phối bởi các tài liệu được cung cấp, sự phù hợp về thời gian cho việc tự học, sự kết nối 

với giảng viên. Nhu cầu cá nhân của nguời học là đa dạng do đặc diểm điều kiện của 

nguời học, điều dó làm tăng nhu cầu được hỗ trợ học tập theo nhóm những nguời học 

có cùng hoàn cảnh điều kiện và nhu cầu học tập.  

- Vấn đề bỏ học/nghỉ học: Do rào cản về khoảng cách địa lý, nên việc quản lý 

người học sẽ thực sự là khó khăn. Vấn đề nghỉ học, hay bỏ học cũng phát sinh nhiều 

đối với đào tạo trực tuyến; 
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- Khả năng tiếp cận với phương pháp học: Khi sinh viên tham gia vào hệ thống lần 

đầu sẽ chưa quen với phương pháp tự học, còn tâm lý trở ngại về sử dụng CNTT. 

- Người học theo phương thức ĐTTT có thể cảm thấy bị cô lập, thất vọng và lo 

lắng ở mức độ cao nếu thiếu các giao tiếp và tương tác giữa các đối tượng trong 

chương trình đào tạo. 

* Về phía người dạy 

- Do việc ĐTTT, học qua mạng không phải là công việc tiến hành thường xuyên 

nên khi bắt tay thực hiện, khá nhiều giáo viên lúng túng về kỹ thuật thực hiện; 

- Phương pháp dạy học đã có nhiều thay đổi; việc vận dụng các phương pháp dạy 

học truyền thống vào ĐTTT có nhiều khó khăn; 

- Khả năng ứng dụng công nghệ thông tin vào dạy học ở nhiều giáo viên còn hạn 

chế, việc sử dụng các phần mềm học trực tuyến chưa thông thạo dẫn đến thực hiện 

chưa hiệu quả. Hơn nữa, đa phần giáo viên đã quen với không gian trực tiếp trước học 

trò, nay đứng trong không gian trực tuyến để giảng bài, nhiều thầy cô sẽ lúng túng 

hoặc không tự tin khi triển khai bài giảng. 

* Về phía cơ sở đào tạo  

- Kiểm soát chất lượng từ các điều kiện triển khai đào tạo đến quá trình tổ chức 

dạy, học, kiểm tra đánh giá.  

- Mức độ sử dụng ĐTTT và cách thức áp dụng tại các cơ sở GDNN khác nhau 

xuất phát từ một số thách thức về nền tảng công nghệ. Ðể thực hiện thành công ÐTTT 

thì các cơ sở GDNN cần tập trung vào các vấn đề về chi phí và công nghệ, cần có chính 

sách đầu tư và đổi mới công nghệ.  

- Phương pháp và kỹ năng của giảng viên trong giảng dạy trực tuyến. Sự thiếu tự 

tin cũng như mức độ hiểu biết hạn chế của giảng viên trong việc sử dụng công nghệ 

mới có khả năng dẫn đến hiệu quả giảng dạy thấp; 

- Tính tương tác và mức độ tương tác giảng viên – sinh viên, sinh viên – sinh viên 

trong môi trường ÐTTT có thể thấp hơn nhiều so với đào tạo truyền thống nếu như hạ 

tầng công nghệ, nội dung đào tạo và phương pháp tổ chức đào tạo không đảm bảo.  
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PHẦN THỨ HAI 

NHỮNG QUY ĐỊNH VỀ ĐÀO TẠO TRỰC TUYẾN 

TRONG GIÁO DỤC NGHỀ NGHIỆP 

Đào tạo trực tuyến là một phương thức đào tạo mới trong lĩnh vực giáo dục nghề 

nghiệp (GDNN). Tuy nhiên, về cơ bản việc đào tạo trực tuyến đã có những quy định 

pháp luật thể hiện tại Thông tư số 09/TT-BLĐTBXH ngày 13/3/2017 quy định việc tổ 

chức thực hiện chương trình đào tạo trình độ trung cấp, trình độ cao đẳng theo niên 

chế hoặc theo phương thức tích lũy mô-đun hoặc tín chỉ; quy chế kiểm tra, thi, xét công 

nhận tốt nghiệp và Thông tư số 33/2018/TT-BLĐTBXH ngày 26/12/2018 của Bộ 

trưởng Bộ Lao động - Thương binh và Xã hội Quy định về đào tạo trình độ cao đẳng, 

trung cấp, sơ cấp theo hình thức đào tạo từ xa, tự học có hướng dẫn và nhiều văn bản 

hướng dẫn khác của Tổng cục Giáo dục nghề nghiệp, Bộ Lao động - Thương binh và Xã 

hội, cụ thể như: 

- Công văn số 345/TCGDNN-ĐTCQ 21/02/2020 về việc đẩy mạnh ứng dụng 

CNTT trong tuyển sinh, tổ chức đào tạo trong bối cảnh dịch COVID-19; 

- Công văn số 587/TCGDNN-ĐTCQ 17/3/2020 về việc hướng dẫn ứng dụng CNTT 

trong tổ chức đào tạo trước bối cảnh dịch bệnh COVID-19; 

- Công văn số 1301/LĐTBXH-TCGDNN 14/4/2020 V/v hướng dẫn thực hiện quản 

lý, tổ chức dạy học, kiểm tra, đánh giá trong đào tạo trực tuyến; 

- Công văn số 1673/LĐTBXH-TCGDNN 15/5/2020 V/v tiếp tục tổ chức giảng dạy, 

học tập bằng hình thức trực tuyến; 

- Công văn số 1819/TCGDNN-ĐTCQ 11/8/2020 V/v tuyển sinh, đào tạo trong tình 

hình dịch bệnh COVID-19 bùng phát trở lại 

 I. Chương trình, giáo trình trong đào tạo trực tuyến 

- Chương trình, giáo trình đào tạo trình độ cao đẳng, trung cấp, sơ cấp theo hình 

thức đào tạo trực tuyến là chương trình, giáo trình đào tạo của ngành, nghề tương ứng 

theo hình thức đào tạo chính quy được cơ sở đào tạo nghề nghiệp điều chỉnh cho phù 

hợp với năng lực của người học, hình thức đào tạo và thời gian đào tạo; 

- Chương trình, giáo trình đào tạo trình độ cao đẳng, trung cấp theo hình thức trực 

tuyến do người đứng đầu cơ sở đào tạo nghề nghiệp tự chủ, tự chịu trách nhiệm xây 

dựng hoặc lựa chọn, phê duyệt, sử dụng theo quy định tại Thông tư số 03/2017/TT-

BLĐTBXH ngày 01/3/2017 của Bộ trưởng Bộ Lao động - Thương binh và Xã hội quy 

định về quy trình xây dựng, thẩm định và ban hành chương trình; tổ chức biên soạn, lựa 

chọn, thẩm định giáo trình đào tạo trình độ trung cấp, trình độ cao đẳng. Cấu trúc của 

chương trình ĐTTT được thực hiện theo như Hộp 1. 

 

 

 

https://drive.google.com/file/d/1o1bUJstUCrVxh2dQYfQc6TCaDoNs57ae/view?usp=sharing
https://drive.google.com/file/d/1o1bUJstUCrVxh2dQYfQc6TCaDoNs57ae/view?usp=sharing
https://thuvienphapluat.vn/van-ban/lao-dong-tien-luong/thong-tu-03-2017-tt-bldtbxh-ban-hanh-chuong-trinh-tham-dinh-giao-trinh-trinh-do-trung-cap-cao-dang-341852.aspx
https://thuvienphapluat.vn/van-ban/lao-dong-tien-luong/thong-tu-03-2017-tt-bldtbxh-ban-hanh-chuong-trinh-tham-dinh-giao-trinh-trinh-do-trung-cap-cao-dang-341852.aspx
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Hộp 1. Cấu trúc của chương trình đào tạo 

Cấu trúc chương trình đào tạo theo từng ngành, nghề được thiết kế gồm: 

1. Tên ngành, nghề đào tạo 

2. Mã ngành, nghề 

3. Trình độ đào tạo 

4. Đối tượng tuyển sinh 

5. Thời gian đào tạo 

6. Mục tiêu đào tạo 

7. Thời gian khóa học 

8. Khối lượng kiến thức toàn khóa học 

9. Danh mục và thời lượng các môn học, mô đun 

10. Chương trình chi tiết các môn học, mô đun 

11. Hướng dẫn sử dụng chương trình đào tạo 

(Điều 4 Thông tư số 03/2017/TT-BLĐTBXH ngày 01/3/2017) 

 II. Thời gian khóa học và đơn vị thời gian trong chương trình đào tạo 

 1. Thời gian khoá học được tính theo năm học, kỳ học và theo tuần 

* Thời gian khoá học theo niên chế 

Thời gian khoá học đối với trình độ cao đẳng từ 2 đến 3 năm học và phải đảm 

bảo khối lượng kiến thức tối thiểu 60 tín chỉ. 

Thời gian khoá học đối với trình độ trung cấp từ 1 đến 2 năm học và phải đảm 

bảo khối lượng kiến thức tối thiểu 35 tín chỉ đối với người có bằng tốt nghiệp THPT, 50 

tín chỉ đối với người có bằng tốt nghiệp THCS. 

Thời gian học tập bao gồm: thời gian thực học và thời gian thi, kiểm tra kết thúc 

môn học, mô đun, thời gian ôn và thi tốt nghiệp. Trong đó, thời gian thực học là thời 

gian HSSV nghe giảng trên lớp, thời gian thí nghiệm, thảo luận, thực tập hoặc học theo 

phương pháp tích hợp giữa lý thuyết và thực hành tại nơi thực hành. 

Thời gian cho các hoạt động chung bao gồm: khai giảng, bế giảng, sơ kết học kỳ, 

tổng kết năm học, nghỉ hè, lễ, tết, lao động và dự phòng. 

* Thời gian khóa học theo tích lũy mô đun hoặc tín chỉ:  

Là thời gian người học tích lũy đủ số lượng mô đun, tín chỉ quy định cho từng 

chương trình đào tạo. 

Thời gian học tập bao gồm: thời gian thực học, thời gian thi, kiểm tra kết thúc 

môn học, mô đun. Thời gian thực học được tính bằng thời gian tổ chức học tập các 

môn học, mô đun. Mỗi môn học, mô đun có khối lượng từ 2 đến 6 tín chỉ tùy theo kết 

cấu của từng môn học, mô đun được thiết kế; với một số môn học, mô đun đặc thù 

hoặc được quy định riêng có thể có số lượng tín chỉ nhỏ hơn 2 hoặc lớn hơn 6. 

https://thuvienphapluat.vn/van-ban/lao-dong-tien-luong/thong-tu-03-2017-tt-bldtbxh-ban-hanh-chuong-trinh-tham-dinh-giao-trinh-trinh-do-trung-cap-cao-dang-341852.aspx
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Thời gian cho các hoạt động chung bao gồm: khai giảng, bế giảng, sơ kết học kỳ, 

tổng kết năm học; thời gian nghỉ hè, lễ, tết, lao động và dự phòng. 

* Thời gian học lý thuyết và thời gian thực hành, thực tập, thí nghiệm tùy theo từng 

ngành, nghề đào tạo phải đảm bảo tỷ lệ sau: 

- Đối với trình độ trung cấp: lý thuyết chiếm từ 25% - 45%; thực hành, thực tập, thí 

nghiệm từ 55% - 75%. 

- Đối với trình độ cao đẳng: lý thuyết chiếm từ 30% - 50%; thực hành, thực tập, thí 

nghiệm từ 50% - 70%. 

 2. Đơn vị thời gian trong chương trình đào tạo 

a) Quy định chung 

- Thời gian học tập tính theo giờ và được quy ra đơn vị tín chỉ để xác định khối 

lượng học tập tối thiểu đối với từng cấp trình độ đào tạo. Đơn vị thời gian trong chương 

trình đào tạo được tính quy đổi như sau: 

+ Một tín chỉ được quy định tối thiểu bằng 15 giờ học lý thuyết và 30 giờ tự học, 

chuẩn bị cá nhân có hướng dẫn hoặc bằng 30 giờ thực hành, thí nghiệm, thảo luận và 

15 giờ tự học, chuẩn bị cá nhân có hướng dẫn hoặc bằng 45 giờ thực tập tại cơ sở, làm 

tiểu luận, bài tập lớn, đồ án, khóa luận tốt nghiệp. Thời gian tự học, chuẩn bị cá nhân có 

hướng dẫn là điều kiện để người học tiếp thu kiến thức, kỹ năng nhưng không tính quy 

đổi ra giờ tín chỉ trong chương trình. 

+ Một giờ học thực hành/tích hợp là 60 phút; giờ học lý thuyết là 45 phút. 

+ Một ngày học thực hành/tích hợp không quá 8 giờ; một ngày học lý thuyết 

không quá 6 giờ. 

+ Mỗi tuần học không quá 40 giờ thực hành/tích hợp hoặc 30 giờ lý thuyết. 

- Thời gian khóa học là thời gian người học hoàn thành chương trình đào tạo, 

được thực hiện linh hoạt và do người đứng đầu cơ sở GDNN quy định phù hợp với 

ngành, nghề đào tạo và đối tượng người học. 

- Thời gian tổ chức giảng dạy được thực hiện linh hoạt theo nhu cầu người học, 

thông qua việc hướng dẫn trực tiếp, trực tuyến, qua các phần mềm, học liệu học tập 

nhưng phải đảm bảo được yêu cầu về nội dung của chương trình đào tạo. 

b) Một số quy định cụ thể 

- Một ngày học trực tuyến không quá 5 giờ (45 phút/giờ học lý thuyết), trong đó 

mỗi giờ học có tối thiểu từ 20 - 30 phút giảng dạy trực tuyến trực tiếp (nếu có thể), thời 

gian còn lại để giảng dạy trực tuyến gián tiếp, trao đổi, giải đáp thắc mắc, giao bài tập 

cho học sinh, sinh viên. Trường hợp việc truy cập internet của học sinh, sinh viên không 

ổn định thì nhà giáo sử dụng toàn thời gian nêu trên vào việc giảng dạy trực tuyến gián 

tiếp (như đã hướng dẫn tại Công văn số 587/TCGDNN-ĐTCQ ngày 17 tháng 3 năm 

2020 của Tổng cục Giáo dục nghề nghiệp về việc hướng dẫn ứng dụng CNTT trong tổ 

chức đào tạo trước bối cảnh dịch bệnh COVID-19); 
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- Thời gian giảng dạy trực tuyến (bao gồm cả trực tiếp và gián tiếp) được tính vào 

định mức giờ giảng của nhà giáo. Người đứng đầu cơ sở giáo dục nghề nghiệp căn cứ 

thời gian giảng dạy, quy mô lớp học để tính giờ chuẩn cho nhà giáo theo quy định tại 

Thông tư số 07/2017/TT-BLĐTBXH ngày 10 tháng 03 năm 2017 của Bộ trưởng Bộ Lao 

động - Thương binh và Xã hội quy định chế độ làm việc của nhà giáo; 

- Thời gian học tập và các hoạt động trong một ngày học trực tuyến có thể thực 

hiện linh hoạt tùy thuộc vào điều kiện và hoàn cảnh thực tế của từng trường do người 

đứng đầu các cơ sở giáo dục nghề nghiệp quyết định. 

 III. Hệ thống quản lý đào tạo trực tuyến 

 1. Hệ thống quản lý học tập bao gồm: 

- Cổng thông tin: Để công bố, giới thiệu các nội dung về chương trình đào tạo; 

thông tin tuyển sinh, điều kiện tuyển sinh; 

- Phân hệ học tập: Để người học truy cập vào các nội dung học tập từ xa và có thể 

tự học tập, tự đánh giá, nắm bắt được tiến trình, kết quả học tập của bản thân; 

- Phân hệ giảng dạy: Để giáo viên, giảng viên quản lý học liệu đào tạo từ xa, thiết 

lập quy luật học, trả bài, thi kiểm tra; theo dõi, tương tác, trợ giúp, hướng dẫn người học; 

xác thực và kiểm soát quá trình học của học viên; quản lý học viên, lớp học; 

- Phân hệ tổ chức thi: Để cơ sở giáo dục nghề nghiệp tổ chức thi, kiểm tra đánh 

giá ghi nhận tiến trình học tập và kết quả học tập của người học; 

- Phân hệ lớp học trực tuyến: Để tổ chức các lớp học trực tuyến theo thời gian 

thực; 

- Ứng dụng trên thiết bị di động: Để thực hiện giảng dạy, học tập dễ dàng, thuận 

tiện trên các thiết bị di động; 

- Phân hệ báo cáo: Để trích xuất được các thông tin của quá trình đào tạo và các 

hoạt động của người dạy, người học; 

- Đội ngũ nhà giáo, cán bộ kỹ thuật, cán bộ hỗ trợ, cán bộ quản lý hệ thống để tổ 

chức đào tạo và quản trị vận hành hệ thống. 

 2. Hệ thống hạ tầng kỹ thuật 

Hệ thống máy chủ và hạ tầng kết nối mạng phải có đủ băng thông, năng lực đáp 

ứng nhu cầu truy cập của người dùng; phải duy trì tối thiểu hai hệ thống hạ tầng kỹ 

thuật để dự phòng lẫn nhau. 

 IV. Tổ chức đào tạo 

 1. Quy định chung 

- Tổ chức đào tạo trực tuyến có thể được thực hiện đối với toàn bộ chương trình 

đào tạo hoặc chỉ áp dụng đối với một số môn học, mô - đun, tín chỉ có nội dung phù 

hợp trong chương trình đào tạo. Việc lựa chọn tổ chức đào tạo trực tuyến toàn bộ 

chương trình hoặc lựa chọn đào tạo một số môn học, mô - đun, tín chỉ trong chương 

trình đào tạo do người đứng đầu cơ sở GDNN quyết định; 



 

17 

- Bắt đầu khóa học cơ sở GDNN tổ chức kiểm tra xem xét và quyết định miễn 

giảm những nội dung môn học, mô - đun, tín chỉ mà người học đã được học, có kết quả 

điểm đạt yêu cầu hoặc số mô - đun, tín chỉ mà người học đã tích lũy được trước khi vào 

học; 

- Quá trình tổ chức đào tạo phải đảm bảo sự tương tác giữa người dạy và người 

học, giữa người học với người học thể hiện ở việc tham dự các buổi học, buổi hướng 

dẫn, thảo luận; hoàn thành việc học tập các nội dung từ các học liệu chính, học liệu bổ 

trợ; thực hiện các bài tập, bài thực hành, đánh giá; phản hồi với người dạy về những nội 

dung giảng dạy, thực hành. 

 2. Quản lý và tổ chức lớp học trực tuyến (theo Công văn số 1301/LĐTBXH-

TCGDNN ngày 14/4/2020 của Bộ Lao động - Thương binh và Xã hội) 

- Người đứng đầu các cơ sở giáo dục nghề nghiệp xây dựng quy chế đào tạo trực 

tuyến trong đó xác định rõ các nội dung cần phải thực hiện như tổ chức lớp học, tổ 

chức dạy học, kiểm tra, đánh giá và chịu trách nhiệm về việc bảo đảm chất lượng đào 

tạo trực tuyến tại trường; 

- Việc tổ chức lớp học trực tuyến được thực hiện theo lớp học truyền thống (lớp 

học trực tiếp tại trường) và được duy trì bằng các phần mềm, ứng dụng đào tạo trực 

tuyến của các cơ sở giáo dục nghề nghiệp xây dựng hoặc các phần mềm, ứng dụng 

khác (zalo, viber, facebook, v.v...) do người đứng đầu các cơ sở giáo dục nghề nghiệp 

quy định; 

- Nhà giáo giảng dạy môn học trực tuyến thực hiện việc quản lý lớp theo quy chế 

đào tạo trực tuyến của cơ sở giáo dục nghề nghiệp, bảo đảm sự tham gia học tập đầy 

đủ của học sinh, sinh viên; thực hiện lưu trữ hồ sơ, tài liệu để làm minh chứng và ghi 

chép hồ sơ, sổ sách trong đào tạo theo quy định tại Thông tư số 23/2018/TT-

BLĐTBXH ngày 06 tháng 12 năm 2018 của Bộ trưởng Bộ Lao động - Thương binh và 

Xã hội quy định về hồ sơ, sổ sách trong đào tạo trình độ trung cấp, trình độ cao đẳng. 

 V. Kiểm tra, đánh giá; thi, xét công nhận tốt nghiệp 

 1. Quy định chung 

- Kiểm tra, thi, xét công nhận tốt nghiệp theo hình thức đào tạo từ xa, tự học có 

hướng dẫn thực hiện theo quy định tại Thông tư số 09/2017/TT- BLĐTBXH ngày 

13/3/2017 của Bộ trưởng Bộ Lao động - Thương binh và Xã hội quy định về tổ chức 

thực hiện chương trình đào tạo trình độ trung cấp, trình độ cao đẳng theo niên chế 

hoặc theo phương thức tích lũy mô - đun hoặc tín chỉ; quy chế kiểm tra, thi, xét công 

nhận tốt nghiệp; 

- Việc kiểm tra, thi, xét công nhận tốt nghiệp có thể thực hiện trực tiếp hoặc gián 

tiếp nhưng phải đảm bảo khách quan, minh bạch, đánh giá được đúng năng lực, kiến 

thức, kỹ năng của người học đã tích lũy được trong quá trình học tập; 

- Người học hoàn thành các môn học, mô - đun, tín chỉ theo hình thức đào tạo 

trực tuyến được cấp chứng nhận hoàn thành môn học, mô - đun, tín chỉ. Chứng nhận 

https://thuvienphapluat.vn/van-ban/giao-duc/thong-tu-09-2017-tt-bldtbxh-dao-tao-trung-cap-cao-dang-tich-luy-mo-dun-tin-chi-kiem-tra-thi-xet-tot-nghiep-325041.aspx
https://thuvienphapluat.vn/van-ban/giao-duc/thong-tu-09-2017-tt-bldtbxh-dao-tao-trung-cap-cao-dang-tich-luy-mo-dun-tin-chi-kiem-tra-thi-xet-tot-nghiep-325041.aspx
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được công nhận trong hệ thống GDNN và được dùng để làm cơ sở tham gia đánh giá 

kỹ năng nghề và công nhận để tiếp tục học lấy bằng tốt nghiệp trung cấp, cao đẳng. 

- Người học hoàn thành chương trình đào tạo theo hình thức trực tuyến được cấp 

bằng tốt nghiệp cao đẳng theo quy định tại Thông tư số 10/2017/TT- BLĐTBXH ngày 

13/3/2017 của Bộ trưởng Bộ Lao động - Thương binh và Xã hội quy định về mẫu bằng 

tốt nghiệp trung cấp, cao đẳng. 

 2. Một số quy định cụ thể (theo Công văn số 1301/LĐTBXH-TCGDNN ngày 

14/4/2020 của Bộ Lao động - Thương binh và Xã hội) 

a) Các hình thức kiểm tra, đánh giá trong ĐTTT 

- Kiểm tra thường xuyên trực tuyến được thực hiện bằng hình thức kiểm tra trắc 

nghiệm hoặc bằng các hình thức kiểm tra, đánh giá khác do nhà giáo giảng dạy tự 

quyết định; 

- Kiểm tra định kỳ trực tuyến được thực hiện theo kế hoạch về kiểm tra định kỳ 

trong chương trình mô đun, môn học, thực hiện bằng hình thức kiểm tra trắc nghiệm 

hoặc kiểm tra viết, chấm điểm tiểu luận do nhà giáo giảng dạy trực tiếp quyết định; 

- Kiểm tra, thi kết thúc mô đun, môn học trực tuyến được thực hiện trực tiếp, tập 

trung tại cơ sở giáo dục nghề nghiệp theo hình thức trắc nghiệm, viết, vấn đáp, bài tập 

lớn, tiểu luận hoặc kết hợp giữa các hình thức trên hoặc được thực hiện gián tiếp theo 

hình thức trực tuyến. Việc kiểm tra, thi kết thúc mô đun, môn học trực tuyến gián tiếp 

do người đứng đầu cơ sở giáo dục nghề nghiệp quyết định về hình thức, cách thức và 

quy trình tổ chức thi, kiểm tra nhưng phải bảo đảm yêu cầu theo quy định. 

b) Về công nhận kết quả kiểm tra, đánh giá trong ĐTTT 

- Các hình thức kiểm tra, đánh giá thường xuyên, định kỳ hoặc thi, kiểm tra kết 

thúc mô đun, môn học theo hình thức trực tuyến (trực tiếp hoặc gián tiếp) được công 

nhận giá trị tương đương như đối với các hình thức kiểm tra, đánh giá truyền thống.  

- Kết quả kiểm tra, đánh giá trực tuyến được ghi vào bảng điểm trong hồ sơ học 

tập và công nhận trong hệ thống giáo dục nghề nghiệp, được dùng làm cơ sở cho việc 

tham gia đánh giá kỹ năng nghề và công nhận để tiếp tục học liên thông với các trình 

độ đào tạo khác; 

- Các quy định khác về tổ chức đào tạo, kiểm tra, đánh giá và công nhận kết quả 

học tập trong đào tạo trực tuyến được thực hiện theo quy định tại Thông tư số 

33/2018/TT-BLĐTBXH ngày 26 tháng 12 năm 2018 của Bộ trưởng Bộ Lao động - 

Thương binh và Xã hội ban hành Quy định về đào tạo trình độ cao đẳng, trung cấp, sơ 

cấp theo hình thức đào tạo từ xa, tự học có hướng dẫn và Thông tư số 09/2017/TT-

BLĐTBXH ngày 13 tháng 3 năm 2017 của Bộ trưởng Bộ Lao động - Thương binh và Xã 

hội quy định về tổ chức thực hiện chương trình đào tạo trình độ trung cấp, trình độ cao 

đẳng theo niên chế hoặc theo phương thức tích lũy mô - đun hoặc tín chỉ; quy chế kiểm 

tra, thi, xét công nhận tốt nghiệp. 

 

 

https://thuvienphapluat.vn/van-ban/giao-duc/thong-tu-10-2017-tt-bldtbxh-mau-bang-tot-nghiep-trung-ca-cao-dan-in-quan-ly-cap-phat-thu-hoi-huy-bo-325042.aspx
https://thuvienphapluat.vn/van-ban/giao-duc/thong-tu-10-2017-tt-bldtbxh-mau-bang-tot-nghiep-trung-ca-cao-dan-in-quan-ly-cap-phat-thu-hoi-huy-bo-325042.aspx
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 VI. Trách nhiệm của cơ sở GDNN trong đào tạo trực tuyến 

- Xây dựng, ban hành quy chế về đào tạo trực tuyến và công khai về chương trình 

đào tạo trong thông báo tuyển sinh và đăng trên trang thông tin điện tử của trường để 

tổ chức thực hiện; 

- Tiếp tục phát huy các hình thức đào tạo trực tuyến đồng thời kết hợp với hình 

thức đào tạo trực tiếp theo truyền thống đối với các nội dung yêu cầu phải có thời gian 

thực hành, thực tập;  

- Khuyến khích đầu tư, xây dựng hệ thống đào tạo trực tuyến chuyên nghiệp bao 

gồm việc học tập trực tuyến (e-learning), hệ thống quản lý học tập trực tuyến (LMS - 

Learning Management System), hệ thống quản lý nội dung học tập (LCMS - Learning 

Content Management System) bằng các giải pháp công nghệ mã nguồn mở như 

Blackboard, Moodle, Canvas, v.v…; 

- Để triển khai thực hiện được các chương trình, ứng dụng đào tạo trực tuyến, các 

cơ sở GDNN cần: 

+ Thành lập nhóm triển khai đào tạo trực tuyến với thành phần chính là cơ quan 

đào tạo và bộ phận công nghệ thông tin của trường; 

+ Xây dựng kế hoạch tổ chức đào tạo trực tuyến trong đó xác định rõ các nội 

dung cần phải thực hiện như:  

+ Xác định các nội dung, môn học lý thuyết để có thể tổ chức đào tạo trực tuyến 

(các môn học chung, các nội dung, hoặc môn học/học phần lý thuyết cơ sở, lý thuyết 

chuyên môn…); 

+ Xây dựng kế hoạch thực hiện chi tiết; lập thời khóa biểu cho việc giảng dạy trực 

tuyến; 

+ Phân công giáo viên phụ trách/giảng dạy để chuẩn bị nội dung bài giảng; các 

điều kiện lớp học, kết nối với HSSV. 

+ Tổ chức biên soạn tài liệu hướng dẫn sử dụng cho giáo viên và HSSV; tập huấn 

sử dụng chương trình, ứng dụng và cách thức thực hiện đào tạo trực tuyến cho giáo 

viên; 

+ Hỗ trợ các điều kiện về cơ sở vật chất, thiết bị (phòng học trực tuyến, máy tính 

có trang bị camera, microphone; máy chụp ảnh, quay phim,….) cho các khoa chuyên 

môn và giáo viên giảng dạy trực tiếp (nếu có); 

+ Thường xuyên, định kỳ kiểm tra, đánh giá việc triển khai thực hiện đào tạo trực 

tuyến trong trường để kịp thời điều chỉnh, rút kinh nghiệm, cải thiện, nâng cao chất 

lượng đào tạo trực tuyến; 

- Thực hiện chế độ báo cáo về đào tạo trực tuyến theo quy định tại Thông tư 

Thông tư số 33/2018/TT-BLĐTBXH và Thông tư số 09/2017/TT-BLĐTBXH. 
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HƯỚNG DẪN SỬ DỤNG 

CÁC PHẦN MỀM ĐÀO TẠO TRỰC TUYẾN 

 I. Các ứng dụng Video call 

 1. Zoom Cloud Meeting 

 

1.1. Cách dùng Zoom dạy học trực tuyến trên máy tính 

▪ Bước 1: Chúng ta tải phần mềm học trực tuyến Zoom rồi tiến hành cài đặt. 

▪ Bước 2: Tiếp đến chúng ta cần đăng ký tài khoản để sử dụng, nhấn vào Sign 

in trong giao diện hiển thị. Sau đó người dùng được lựa chọn những phương 

thức tạo tài khoản Zoom, qua email, qua SSO, Google hoặc qua Facebook. Chúng 

ta nên chọn đăng ký qua Google để liên kết với tài khoản Google đang dùng và 

tạo ngay được tài khoản Zoom. 

 

▪ Bước 3: Khi đã có tài khoản bạn được chuyển vào giao diện chính của phần mềm. 

Tại thanh ngang trên cùng sẽ có 4 nhóm quản lý chính gồm: 

- Home: Nhấn để quay lại màn hình Trang chủ. 
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- Chat: Hiện cửa sổ, nhóm chức năng Trò chuyện. 

- Meetings: Hiện cửa sổ, nhóm chức năng Họp. 

- Contacts: Quản lý các địa chỉ liên lạc. 

- Bên dưới là 4 phần chức năng chính để tạo phòng học, tham gia phòng học 

khác. 

- New Meeting: Tạo phòng họp, phòng học mới. 

- Join: Truy cập vào phòng học, phòng họp khác. 

- Schedule: Lên lịch, quản lý thời gian các buổi học. 

- Share Screen: Chia sẻ màn hình máy tính của mình cho người khác. 

 
▪ Bước 4: Để tạo phòng học trực tuyến trên Zoom bạn nhấn vào New Meeting. 

Hiển thị giao diện màn hình webcam với các tùy chọn phòng học bên dưới. 

Để mời giáo viên hoặc học sinh, sinh viên tham gia phòng học nhấn vào Invite. 

Lưu ý tới Meeting ID để gửi cho người khác muốn tham gia. 

 
▪ Bước 5: Hiển thị giao diện, chúng ta nhấn vào Copy URL rồi gửi cho những người 

bạn muốn mời học tham gia. Người tham gia cũng cần có tài khoản sử dụng. 
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▪ Bước 6: Khi người khác muốn tham gia phòng học trực tuyến trên Zoom thì nhấn 

Join. Sau đó điền ID của phòng học được cung cấp và điền tên của người muốn 

tham gia. Cuối cùng nhấn Join để tham gia. 

 

Mặc định khi học trực tuyến trên Zoom đều thu âm thanh và hiện sẵn webcam. Lưu ý 

nếu học trực tuyến trên Zoom bằng điện thoại thì bạn cũng cần nhập ID phòng học và 

tên của mình để tham gia. 

Hướng dẫn dùng phòng học trên Zoom 

Giao diện phòng học trực tuyến trên Zoom có giao diện như dưới đây 
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Các biểu tượng có nội dung gồm: 

- Join Audio: Thiết lập âm thanh trên Zoom. Nếu Zoom lỗi âm thanh thì bạn chỉnh 

sửa tại Settings. 

- Stop Video: Tắt webcam và thay bằng ảnh logo hoặc đổi nền video học trên 

Zoom. 

- Invite: Mời người khác tham gia phòng học. Bạn tham khảo bài viết Cách đăng ký 

Zoom.us học trực tuyến miễn phí để biết cách mời tham gia phòng trực tuyến 

trên Zoom. 

- Manage Participant: Quản lý người tham gia phòng học. Nếu tạo phòng học trên 

Zoom có thể đổi host phòng học trên Zoom, xóa thành viên bất kì khỏi phòng học 

hoặc tắt âm (mute) của thành viên đó trong lớp học. 

- Share Screen: Chia sẻ màn hình. Nếu bạn muốn bảo mật thông tin trên Zoom, 

hạn chế việc chia sẻ ảnh màn hình không cần thiết trừ host phòng học thì nhấn 

Advanced Sharing Options. 

- Chat: Gửi tin nhắn. 

- Record: Ghi video buổi học trên Zoom. 

- Reactions: Gửi biểu tượng cảm xúc. 

- End Meeting: Kết thúc buổi học. 

1.2. Cách sử dụng Zoom meeting trên điện thoại 

▪ Bước 1: 

Chúng ta cài ứng dụng Zoom Meeting cho Android và iOS. Tại giao diện đầu tiên 

ta nhấn Sign In để đăng nhập tài khoản qua Google hoặc Facebook. 

https://quantrimang.com/cach-fix-loi-su-dung-zoom-hoc-online-170514
https://quantrimang.com/su-dung-virtual-background-cua-zoom-170668
https://quantrimang.com/su-dung-virtual-background-cua-zoom-170668
https://quantrimang.com/cach-dang-ky-zoom-us-170720
https://quantrimang.com/cach-dang-ky-zoom-us-170720
https://quantrimang.com/cach-doi-host-lop-hoc-truc-tuyen-tren-zoom-170722
https://quantrimang.com/cach-bao-mat-tai-khoan-zoom-170885
https://quantrimang.com/cach-ghi-video-hoc-online-tren-zoom-meeting-170605
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▪ Bước 2: 

Trong giao diện chính của ứng dụng người dùng sẽ nhìn thấy các tùy chọn tham 

gia học trực tuyến trên Zoom. Nếu muốn tham gia phòng học trực tuyến của 

thầy cô giáo thì nhấn Join. Sau đó bạn nhập ID phòng học nhận được và mật 

khẩu của phòng học từ người tạo phòng. 
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▪ Bước 3: 

Khi đó bạn sẽ nhìn thấy giao diện màn hình học xem trước, nhấn Join with a 

Video. Kết quả bạn đã tham gia thành công phòng học trực tuyến trên Zoom. Để 

thoát phòng học nhấn Leave. Lưu ý để thu được âm thanh thì nhấn Join Audio. 

 

 
 

Hướng dẫn sử dụng Zoom Cloud Meeting: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-zoom-

cloud-meeting 

 

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-zoom-cloud-meeting
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-zoom-cloud-meeting
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 2. Google Hangouts Meet 

 

2.1. Google meet là gì? 

Google meet là hệ thống học/họp trực tuyến qua mạng trên nền Web được tích 

hợp trong bộ G-suite của Google, do đó cán bộ và sinh viên Trường có thể sử dụng 

Google meet để tổ chức các buổi học/họp trực tuyến qua mạng với số lượng người 

tham gia đồng thời lên đến 250 người.  

2.2. Một số lưu ý khi sử dụng Google meet 

- Tất cả người dùng thuộc miền .edu.vn đều có quyền khởi tạo và chủ trì một cuộc 

họp hay một buổi học trực tuyến. 

- Số người tham gia học/họp trực tuyến tối đa: 250 người. 

- Nếu sử dụng máy tính thì Google Meet hoạt động tốt nhất trên trình duyệt 

web Google Chrome. 

- Hỗ trợ điện thoại thông minh trên nền IOS và Android (Thông qua ứng dụng trên 

mobile Hangouts Meet). 

- Hỗ trợ ghi hình buổi học/họp và lưu trữ trên Google Drive. 

- Rất dễ sử dụng và hoàn toàn miễn phí. 

- Tích hợp với các công cụ khác trên bộ G-suite như: Lịch, Classroom. 

2.3. Một số lưu ý khi họp trực tuyến: 

- Nếu hai thành viên trong cùng một phòng (phòng làm việc) cùng kết nối vào một 

buổi học/họp trực tuyến sẽ gây ra hiện tượng vọng âm, do đó nếu nhiều hơn 02 thành 

viên tham học/họp trong cùng một phòng thì sử dụng chung một máy tính để kết nối 

vào buổi học/họp trực tuyến. 

- Trong quá trình học/họp trực tuyến nếu một thành viên phát biểu thì các thành 

viên khác nên tắt micro của mình để tranh gây tiếng ồn. 

- Đối với học/họp trực tuyến băng thông mạng là yếu tố quyết định, do đó khi tổ 

chức họp trực tuyến chúng ta nên giảm thiểu việc sử dụng mạng cho các hoạt động 

khác. 
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2.4. Hướng dẫn tạo một buổi học / họp trực tuyến 

▪ Bước 1: Trên Google Chrome Đăng nhập vào hệ thống email 

 

▪ Bước 2: Truy cập vào: meet.google.com hoặc click vào biểu tượng Google 

Apps chọn Meet 
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▪ Bước 3: Click vào Tham gia hoặc bắt đầu cuộc họp (Join or Start a meeting) 

 

 

▪ Bước 4: Đặt tên cho buổi học/họp và chọn Continue 
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▪ Bước 5: Chọn More Option và Setting để cấu hình Camera và Micro nếu cần 

thiết (thường không cần điều chỉnh vì hệ thống tự nhận biết). Sau khi thiết lập 

xong (nếu có) chọn Tham gia cuộc họp (Join Meeting) 

 

▪ Bước 6: Mời các thành viên tham gia họp bằng cách chép và chuyển (email) cho 

họ liên kết (URL) của cuộc họp. Quí thầy cô giảng dạy lớp học phần có thể sử 

dụng địa chỉ email của lớp học phần để mời tất cả sinh viên tham gia lớp học. 

 

Hoặc chọn Thêm người (Add people) để mời, với cách mời này chúng ta có thể 

thêm từng người hoặc Copy và Paste danh sách email của nhiều người (tối đa một lần 

chép và dán là 30 email).  

Lưu ý: Chỉ những email có cùng tên miền tổ chức mới có thể nhận lời mời tham 

gia vào nhóm. 
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▪ Bước 7: Ghi hình cuộc họp chọn nút Tùy chọn và chọn Ghi lại cuộc họp để 

ghi (file video sẽ được lưu trên Google Drive và hệ thống sẽ có email thông báo tên 

file cho người ghi hình), Khi muốn kết thúc ghi hình chọn Tùy chọn và chọn Dừng 

ghi 

 

▪ Bước 8: Thuyết trình trong cuộc họp, chọn Trình bày ngày bây giờ (Present now), 

chọn Toàn bộ màn hình của bạn (Your entire screen) và mở tập tin để trình 

chiếu. 
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2.5. Tham gia buổi học / họp trực tuyến 

Thành viên được mời sẽ nhận được thông báo qua email và nhắp chuột vào Join 

meeting hoặc URL nhận được. 

 

Hướng dẫn sử dụng Google Hangouts Meet: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

google-hangout-meet 

 

 

 3. Skype Meet now  

 

Skype mới bổ sung tính năng Meet Now cho các phiên bản của Skype bao gồm 

Skype trên máy tính, Skype nền web và Skype trên điện thoại để người dùng tạo cuộc 

họp trực tuyến, chat video nhóm từ xa. Như vậy công cụ chat video Skype đã vốn quen 

thuộc với người dùng tại Việt Nam cũng đã có mặt trong đội ngũ các phần mềm học 

trực tuyến, tổ chức hội nghị từ xa cùng với tạo phòng học trên Zoom và họp từ xa trên 

Microsoft Teams. 

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-google-hangout-meet
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-google-hangout-meet
https://quantrimang.com/cach-hoc-truc-tuyen-tren-zoom-169997
https://quantrimang.com/cach-thiet-lap-microsoft-teams-lam-viec-nhom-tu-xa-170340
https://quantrimang.com/cach-thiet-lap-microsoft-teams-lam-viec-nhom-tu-xa-170340
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Giao diện của Meet Now Skype cũng có đầy đủ các tùy chọn để liên lạc với nhiều 

người, ghi âm cuộc gọi và lưu lại cuộc gọi video khi cần thiết. Bài viết dưới đây sẽ 

hướng dẫn bạn sử dụng Meet Now trên Skype. 

Để bắt đầu sử dụng Meet Now của Skype bạn cần làm 2 việc sau: 

 Tải Skype về máy tính, điện thoại 

 Tạo tài khoản Skype nếu bạn chưa có 

Meet Now hỗ trợ tối đa 50 người 

Hướng dẫn dùng Meet Now trên Skype PC 

▪ Bước 1: 

Trước hết bạn cần cập nhật Skype trên máy tính lên bản mới nhất để có tính năng 

Meet Now. Mở Skype lên và nhấp vào Meet Now như hình dưới đây. 

 

▪ Bước 2: 

Link tham gia họp nhóm Skype sẽ xuất hiện, bạn dùng link này để gửi tới các 

thành viên. Nhấn Share invite để chọn cách thức chia sẻ, hoặc nhấp vào biểu 

tượng Copy ở bên phải link để sao chép link. 

Trước khi tham gia họp video nhóm trên Skype bạn có thể điều chỉnh bật tắt 

micro, webcam, hay bật/tắt chế độ làm mờ nền tại Blur my background. Khi 

người khác tham gia họp nhóm bạn sẽ nhận được tin nhắn. Với người dùng Skype 

Android, iOS thì nhấn Meet Now để tham gia. 
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▪ Bước 3: 

Nhấn Start Call để bắt đầu họp nhóm trên Skype. Người tham gia vào họp nhóm 

cũng có thể mời tiếp những người khác tham gia thông qua link. 

Đây là giao diện gọi video nhóm trên Skype để họp trực tuyến. Màn hình video 

của các thành viên tham gia sẽ hiển thị trên giao diện. Các biểu tượng trong giao 

diện gồm: 

 Share call link: Chia sẻ link để thêm người họp trực tuyến. 

 Start recording: Ghi lại màn hình họp online. 

 Audio, webcam: Bật tắt âm thanh, video. 

 End Call: Dừng cuộc gọi. 

 Chat: Mở hộp thoại chat bên phải màn hình. 

 Share screen: Chia sẻ màn hình trên cuộc gọi. 

 Reaction: Gửi biểu tượng cảm xúc. 

 More: Thêm tùy chọn họp trực tuyến. 

 Call layout: Thay đổi cách hiển thị giao diện màn hình. 

 Add people to the call: Thêm người vào họp trực tuyến. 

 

▪ Bước 4: Chia sẻ màn hình trên Skype 
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Để chia sẻ màn hình trên Skype bạn chọn Share application, màn hình các ứng 

dụng đang mở trên máy tính sẽ hiện ra, chọn cái cần chia sẻ. Nếu muốn chia sẻ 

âm thanh máy tính thì bật Share computer sound, rồi nhấn Start sharing. 

 

▪ Bước 5: 

Để tùy chỉnh lại thiết bị âm thanh và video trên Skype người dùng nhấn vào biểu 

tượng More rồi chọn Audio and Settings. 

 

Hướng dẫn sử dụng Skype Meet Now: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-skype-

meet-now 

 

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-skype-meet-now
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-skype-meet-now
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 II. Các ứng dụng đào tạo trực tuyến 

 1. Microsoft Teams  

 

Microsoft Teams là một không gian làm việc để cộng tác, giao tiếp trong các 

cuộc họp, cho phép chia sẻ tệp và ứng dụng giúp cuộc họp luôn được diễn ra thuận lợi, 

hiệu quả. 

* Tạo nhóm 

Chọn Join or create a team. Đây là nơi tạo nhóm của riêng mình hoặc khám phá 

các nhóm hiện có. 

Bước 1: Chọn Create team để tạo nhóm mới. 

 
Bước 2: Đặt tên cho nhóm và thêm mô tả ngắn nếu ta muốn. 
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Bước 3: Theo mặc định, nhóm của ta là Private, nghĩa là ta sẽ phải thêm người 

hoặc nhóm ta muốn vào nhóm. 

 
Bước 4: Chọn Public nếu ta muốn bất kỳ ai trong tổ chức có thể tìm và tham gia 

nhóm. 

Bước 5: Thêm thành viên. Ta có thể thêm người, nhóm hoặc thậm chí toàn bộ 

nhóm liên hệ. 
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Nếu ta cần thêm người từ bên ngoài tổ chức của mình, hãy sử dụng địa chỉ email 

của họ để mời họ làm khách. Thêm tên hiển thị thân thiện cho họ. 

Bước 6: Khi ta hoàn tất việc thêm thành viên, hãy chọn Add rồi đến Close. 

Lưu ý: Nếu ta là quản trị viên, hãy cân nhắc tạo nhóm hoàn toàn tự động thêm 

mọi người trong tổ chức của ta. 

* Tạo kênh 

Theo mặc định, mọi nhóm đều có kênh General, một kênh tốt để sử dụng cho các 

thông báo và thông tin mà cả nhóm cần. Để thêm nhiều hơn: 

Bước 1: Chọn More options bên cạnh tên nhóm. 

Bước 2: Chọn Add chanel. 

 

Bước 3: Nhập tên và mô tả cho kênh của ta. Ta có thể xây dựng một kênh xung 

quanh một chủ đề, dự án, tên bộ phận hoặc bất kỳ thứ gì ta thích. 

Bước 4: Chọn Automatically favorite this channel for the whole team. Nếu ta 

muốn kênh này tự động hiển thị trong danh sách kênh của mọi người. 
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Bước 5: Chọn Add. 

* Tùy chỉnh và quản lý nhóm của ta 

Bước 1: Chọn More options bên cạnh tên nhóm. 

Bước 2: Chọn Manage team để tìm Thành viên, Kênh, Cài đặt và Ứng dụng cho 

nhóm của ta ở cùng một nơi. 

 

Bước 3: Chọn Cài đặt > Hình ảnh nhóm để thêm ảnh nhóm và cung cấp cho 

nhóm của ta một số tính cách. 

* Bắt đầu cuộc trò chuyện, cuộc gọi và cuộc họp 
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* Bắt đầu cuộc trò chuyện 

Bước 1: Chọn New chat để bắt đầu một cuộc trò chuyện mới. 

Bước 2: Nhập tên của người hoặc những người ta muốn liên hệ. 

Bước 3: Chọn mũi tên xuống để thêm tên vào nhóm trò chuyện của ta. 

 

* Thực hiện cuộc gọi video 

Chọn Video call hoặc Audio call để gọi cho ai đó trực tiếp từ cuộc trò chuyện. 

 

Hướng dẫn sử dụng Microsoft Teams: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

microsoft-teams 

 

 

 

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-microsoft-teams
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-microsoft-teams


40 

 2. Google Classroom  

 

Google Classroom là một công cụ giúp giảng viên tổ chức và quản lý lớp dễ dàng, 

thuận tiện, tất cả tài liệu, bài tập, và điểm số đều được lưu ở cùng một nơi. Ngoài phiên 

bản web, Google Classroom cũng có phiên bản trên Android và iOS cho phép học sinh, 

giảng viên theo dõi, cập nhật tình hình lớp học ở bất kỳ nơi đâu. Google Classroom tích 

hợp Google Docs, Google Drive và Gmail nhằm mục đích giúp đơn giản hóa công việc 

giảng dạy và học tập. Dưới đây là một số tiện ích: 

1. Một trong những lợi ích nổi trội của Google Class đó là giúp giảm thiểu được 

việc sử dụng giấy (in ấn tài liệu, nộp bài tập…) trong lớp học. 

2. Giúp giảng viên tổ chức và quản lý lớp dễ dàng, thuận tiện; tất cả tài liệu, bài tập 

và điểm đều ở cùng một nơi (trong Google Drive). 

3. Ngoài phiên bản web, Google Classroom đã có phiên bản trên Android và iOS 

cho phép người học truy cập vào Lớp học nhanh hơn, luôn cập nhật mọi thông 

tin về lớp học khi di chuyển. 

4. Tài khoản Google của Trường đã được cấp với dung lượng không giới hạn. Điều 

này là một thuận lợi rất lớn trong việc sử dụng Google Classroom, giảng viên có 

thể lưu trữ toàn bộ tài liệu giảng dạy, video tham khảo, hình ảnh lớp học, 

điểm,…ngay trên Drive của lớp học này và chia sẻ cho sinh viên mà không phải 

bận tâm về không gian lưu trữ. 

5. Giảng viên và sinh viên có thể theo dõi, cập nhật tình hình lớp học ở bất kỳ nơi 

đâu (chỉ cần có laptop, tablet hay điện thoại có kết nối internet). 

6. Các thông báo tức thời và các trao đổi trên diễn đàn được thực hiện dễ dàng. 

* Học viên học tập trên Classroom 

Truy cập đường dẫn https://classroom.google.com hoặc bấm vào biểu tượng 

“Lớp học” trên thanh ứng dụng của Google 

Sau đó đăng nhập vào bằng một tài khoản gmail cá nhân. 

https://classroom.google.com/
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* Tham gia lớp học 

Cách 1: Tự đăng ký lớp học khi biết mã lớp 

Bước 1: click chọn vào biểu tượng + 

 

Bước 2: Nhập mã lớp do giảng viên cung cấp để tham gia lớp học 
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Cách 2: Nhận email mời vào lớp học từ giảng viên 

Giảng viên sẽ mời sinh viên tham gia lớp học bằng cách gửi mail đến sinh viên, 

sinh viên check mail để tham gia lớp học. 

Người học đăng nhập và mở email ra và mở mail “lời mời tham gia lớp học….” 

nhấp chuột vào dòng “Tham gia” 

 

Sau khi tham gia lớp học thành công, ta có thể xem các nội dung thông báo hoặc 

bài tập của giảng viên gửi ở phần Luồng 

 

* Tạo bài đăng chia sẽ với các bạn trong lớp 

Bước 1: Sinh viên chọn lớp học cần tạo bài đăng 

Bước 2: Click chọn biểu tượng “Tạo bài đăng” 
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Bước 3: Nhập nội dung cần đăng 

Nếu nội dung bài đăng nhiều, Sinh viên có thể gửi nội dung bài đăng dưới dạng một 

tập tin đính kèm từ máy sinh viên, hoặc từ Drive trong hộp thư của sinh viên. Ngoài ra 

sinh viên có thể gửi một nội dung dưới dạng video được thu hình sẵn (được upload lên 

Youtube), hoặc một địa chỉ website liên quan đến bài đăng của mình, giúp các bạn sinh 

viên trong lớp cái nhìn trực quan hơn. 

 

Sau khi tạo xong sinh viên nhấn “đăng” để gửi nội dung cho các bạn trong lớp. 

* Xem và Nộp bài tập theo yêu cầu của giáo viên 

Chọn bài tập cần xem: 

 

Chúng ta có thể thêm tập tin đính kèm 
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Thêm file đính kèm: Sinh viên có thể gửi nội dung bài đăng dưới dạng một tập tin 

đính kèm từ máy sinh viên, hoặc từ Drive trong hộp thư của sinh viên. Ngoài ra sinh 

viên có thể gửi một nội dung dưới dạng video được thu hình sẵn (được upload lên 

Youtube), hoặc một địa chỉ website liên quan đến bài đăng của mình. 

Sau khi tạo xong sinh viên nhấn “đăng” để gửi nội dung cho các bạn trong lớp. 

 

Hoặc sinh viên cũng có thể thêm các nhận xét về bài tập: nhận xét có thể là công 

khai nếu muốn mọi người đều đọc được hoặc là nhận xét riêng tư để giáo viên có thể 

đọc. 

* Hủy đăng ký lớp học 

Vì một lý do nào đó, có thể đăng ký nhầm,… học viên cần hủy lớp học đã đăng ký. 

để hủy lớp học cũng khá đơn giản. Chọn theo cái mũi tên ở hình dưới. 

Bước 1: Ta chọn trang chủ “lớp học” của Classroom 
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Bước 2: Nhấp vào dấu “…” -> Chọn “Hủy Đăng Ký” -> Xác nhận hủy đăng ký 

 

 

Hướng dẫn sử dụng Google Classroom: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

google-classroom 

   

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-google-classroom
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-google-classroom
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 III. Hướng dẫn xây dựng hệ thống LMS bằng mã nguồn mở 

 1. Xây dựng hệ thống LMS bằng Moodle 

1.1. Giới thiệu về Moodle 

Moodle là một hệ thống quản lý học tập gọi tắt là LMS (Learning Management 

System) hoặc còn được gọi là CMS (Course Management System) hay VLE (Virtual 

Learning Environment). Đây là chương trình có mã nguồn mở (có thể chỉnh sửa được 

mã nguồn), cho phép tạo các khóa học trên mạng Internet hay các website học tập 

trực tyến.  

Moodle (viết tắt của Modular Object-Oriented Dynamic Learning Environment) 

được sáng lập năm 1999 bởi Martin Dougiamas, người tiếp tục điều hành và phát triển 

chính của dự án. Do không hài lòng với hệ thống LMS/LCMS thương mại WebCT trong 

trường học Curtin của Úc, Martin đã quyết tâm xây dựng một hệ thống LMS mã nguồn 

mở hướng tới giáo dục và người dùng hơn. Từ đó đến nay Moodle có sự phát triển vượt 

bậc và thu hút được sự quan tâm của hầu hết các quốc gia trên thế giới và ngay cả 

những công ty bán LMS/LCMS thương mại lớn nhất như BlackCT (BlackBoard + 

WebCT) cũng có các chiến lược riêng để cạnh tranh với Moodle. 

Hiện nay, Moodle là hệ thống được sử dụng nhiều nhất với những đặc điểm nổi bật 

của Moodle như: 

1. Moodle là thiết kế hướng tới giáo dục, dành cho những người làm trong lĩnh vực 

giáo dục. 

2. Moodle có giao diện trực quan, giáo viên/người hướng dẫn dễ dàng làm quen và 

sử dụng thành thạo, chỉnh sửa và nâng cấp trong thời gian ngắn. 

3. Cho phép sử dụng các chỉnh sửa giao diện bằng cách dùng các theme có trước 

hoặc tự tạo mới. 

4. Tài liệu hỗ trợ đồ sộ và chi tiết, khắc hẳn với nhiều dự án mã nguồn mở khác 

5. Moodle phù hợp với nhiều cấp học và hình thức đào tạo: Phổ thông, Đại 

học/Cao đẳng, chính quy/không chính quy, hay trong đào tạo của các tổ chức, 

doanh nghiệp. 

6. Moodle rất đáng tin cậy, có trên 10 000 site trên thế giới. Hiện nay, Moodle được 

sử dụng tại 160 quốc gia và đã được dịch ra 75 ngôn ngữ khác nhau. Có 

trên 100 nghìn người đã đăng kí tham gia cộng đồng Moodle (moodle.org) và 

sẵn sàng giúp bạn giải quyết khó khăn. Nếu bạn cần sự giúp đỡ chuyên nghiệp 

về cài đặt, hosting, tư vấn sử dụng Moodle, phát triển thêm các tính năng mới, 

và tích hợp Moodle với các hệ thống đã có trong trường của bạn, bạn có thể 

chọn cho mình một trong các công ty Moodle Partners. 

7. Moodle phát triển dựa trên mã nguồn mỡ Personal Home Page - PHP (Ngôn 

ngữ được dùng bởi các công ty Web lớn như Yahoo, Flickr, Baidu, Digg, CNET) 

có thể mở rộng từ một lớp học nhỏ đến các trường đại học lớn trên 50 000 sinh 

viên (ví dụ đại học Open PolyTechnique của Newzealand hoặc sắp tới đây là đại 

học mở Anh - Open University of UK, trường đại học cung cấp đào tạo từ xa lớn 

nhất châu Âu, và đại học mở Canada, Athabasca University). Bạn có thể dùng 

https://moodle.org/mod/data/view.php?d=13&rid=106
http://www.blackboard.com/
http://docs.moodle.org/en/Philosophy
https://moodle.org/mod/resource/view.php?id=5479
https://moodle.org/stats/
http://moodle.com/partners/list/
http://docs.moodle.org/en/Installations_10000_plus


 

47 

Moodle với các database mã nguồn mở như MySQL hoặc PostgreSQL. Phiên 

bản 1.7 sẽ hỗ trợ thêm các database thương mại như Oracle, Microsoft SQL để 

các bạn có thêm nhiều cơ hội lựa chọn. 

1.2. Hướng dẫn cài đặt Moodle 

Để cài đặt Moodle vào máy chủ chúng ta thực hiện theo các bước sau: 

Đầu tiên sau khi chúng ta được cung cấp tên miền, ID và password từ Công ty đại 

diện, nhà đăng ký kích hoạt gửi cho mình. 

 

Chúng ta Copy dòng tên miền đưa vào trình duyệt tùy chọn (Google Chrome, Cốc 

Cốc,…) và trình tự đăng nhập với ID và Password đã được cung cấp ➔ Click SIGN IN 

TO ACCOUNT 

 

Tại trình duyệt này, các bạn tìm mục Access Level ➔ User ➔ Softaculous Auto 

Installer 

Thông tin từ Công ty đại diện, nhà đăng kí kích hoạt cung cấp 
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Tiếp tục nhập Moodle tại ô tìm kiếm và chọn Moodle 

 

Các bạn tiếp tục chọn Install Now 

 

Ở đây mọi người chú ý bên phải màn hình chọn ô moodle 30 và xóa hết nội dung 

đó 
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Chú ý: Admin Username và Admin Password các bạn copy và lưu lại khi các bạn 

cần đăng nhập 

Sau khi đã lưu thông tin trên thì các nội dung khác các bạn không cần thay đổi 

nội dung đã mặc định. Kéo xuống cuối trình duyệt các bạn chọn Instal để hoàn tất và 

bắt đầu cài đặt. 

 

Quá trình cài đặt thường sẽ mất khoảng 3 đến 4 phút.  

 

Sau đó chúng ta sẽ tiến hành kiểm tra trang web với tên miền mới bằng cách 

chọn copy đường dẫn đưa lên trình duyệt. 
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Như vậy chúng ta đã hoàn thành quá trình cài đặt Moodle lên máy chủ. 

1.3. Hướng dẫn sử dụng hệ thống quản lí học tập Moodle 

Sau khi đã cài đặt thành công Moodle vào máy chủ, để sử dụng Moodle các bạn 

cần phải nâng cấp, chỉnh sửa và quản trị Moodle theo những hướng dẫn sau: 

* Thay đổi thông tin cá nhân và thông tin tài khoản quản trị 

Chúng ta dùng thông tin đã lưu trước (Username và Userpassword) để đăng 

nhập vào tài khoản:  

 

Di chuyển chuột sang góc phải màn hình vào mục System Administrator ➔ 

Profile ➔ Edit Profile,  
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Sau đó các bạn thay đổi thông tin cần thiết: 

- Username: mọi người có thể đổi tên tùy thích, ở đây chúng tôi để mặc định là 

admin 

- Trình tự thay đổi: First name, Surname, Email address,… 

- Quốc gia: Viet Nam 

- Chọn Vùng: asia/Ho_Chi _Minh  

- Các thông tin khác chúng ta để mặc định sẵn 

Cuối cùng chúng ta kết thúc thay đổi bằng cách click Update profile 

* Thay đổi giao diện Moodle 

Hiện tại Moodle đang có giao diện mặc định, đó là giao diện mới nhất hiện nay 

nhưng do các bạn mới làm quen với Moodle nên các bạn nên sử dụng giao diện dễ sử 

dụng hơn. 

Đầu tiên các bạn chọn Site Administration ➔ Appearapce ➔ Theme selector 

Tại giao diện mặc định (Theme Default) ta thay đổi từ giao diện Boost sang giao 

diện Classic bẳng cách click vào Use Theme ở giao diện Classic ➔ Continue để hoàn 

thành thay đồi giao diện. 

 

Như vậy các bạn đã thay đổi thành công giao diện cho Moodle 

* Thêm gói Tiếng Việt cho Moodle 
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Tại trang chủ, chúng ta vào mục Site administration và tiếp tục di chuyển xuống 

chọn Language ➔ Language packs 

 

Các bạn tìm chọn tiếng Việt - Vietnamese (Vi) bên phải màn hình và nhấn Install 

selected language pack(s) 

 

Sau đó các bạn chọn Update all installed language packs 

 

Các bạn cần chọn chế độ tiếng Việt ở thanh Menu bên phải trên màn hình thì khi 

đó mới chính thức hoàn thành thao tác thay đổi tiếng Việt trên Moodle 
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* Tạo Block trên Moodle 

Đầu tiên tại trang chủ chúng ta bật chế độ chỉnh sửa Turn editing on, di chuyển 

xuống dưới phần Add ablock ➔ Add ➔ Logged in user  

 

Di chuyển thêm xuống phần thông tin của người đăng nhập ➔ chọn biểu tượng 

cài đặt để chúng ta cài đặt vị trí cũng như hiển thị block trên giao diện của chúng ta 

bằng cách chọn Configure Logged in user block 

 

Tại trình duyệt này có thể tùy chọn Yes hoăc No theo nhu cầu. Các bạn muốn 

hiển thị lần truy cập đầu tiên (Display first access) và lần cuối cùng truy cập (Display 

last access) các bạn chọn Yes 

Để biết 2 mục trên nẳm ở trang nào thì các bạn vào “Where this block appears” 

và mặc định thì sẽ hiển thị trên trang chủ mà thôi 
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Và để có thể hiển thị trên tất cả các trang thì các bạn vào mục Default region ➔ 

Display throughout the entire site 

 

Vị trí Default region cụ thể mặc định là bên trái thì chúng ta có thể thay đổi lên 

trên cùng của trang là -10 (first).  

Lưu thay đổi lại click Save Changes 

* Thêm Blog đăng nhập 

Vào Add ➔ Login ➔ chọn biểu tượng cài đặt ➔Configure, đặt lại vị trí hiển thị 

cho Block, sau khi thay đỗi xong các bạn chọn Save Changes 

 

Các bạn thử logout để thấy được vị trí của Block đăng nhập 

 

* Di chuyển Block trên Moodle 

Các bạn chọn Administration ➔ Turn editing on sau đó các bạn chú ý biểu tượng 

mũi tên 4 hướng trên mỗi Block, đó là biểu tượng di chuyển các block. Các bạn di 

chuyển chuột đến biểu tượng mũi tên nhấn giữ chuột trái và di chuyển block 
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đến vị trí bạn muốn đặt  

* Thêm phần giới thiệu công ty trên trang chủ 

Chọn Turn editing on tại Administration ➔ Chọn biểu tượng cài đặt sau đó 

chúng ta đưa nội dung giới thiệu Công ty mà các bạn đã soạn sẵn, chỉ cần copy và dán 

vào khung chèn nội dung mà thôi. 

 

Nếu muốn thêm hình ảnh thì các bạn chọn biểu tượng Insert or edit image, các 

bạn có thể chọn “Upload a file” hoặc “Chọn tệp” để đưa hình ảnh vào  

 
* Tạo danh mục trên Moodle 

Đầu tiên các bạn tìm và chọn mục Site administration ➔ Courses ➔Add a 

category 
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Tại đây các bạn luôn để Parent category là Top, tiếp theo là đặt tên cho danh 

mục, ví dụ: “Tiếng Anh Giao Tiếp”, ID number chúng ta để trống. Kế đến nhập nội dung 

các bạn muốn giới thiệu ➔ Create category là chúng ta đã tạo xong danh mục “Tiếng 

Anh Giao Tiếp” 

 

Để tạo thêm 1 danh mục mới nữa các bạn chọn Create new category 

 

Nếu các bạn muốn tạo danh mục mới ngang hang với danh mục “Tiếng Anh Giao 

Tiếp” thì các bạn lại chọn Top … và đặt tên là “Tài liệu tiếng Anh”, tương tự các bạn tự 

do thêm nội dung cần thiết. 
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Còn Nếu các bạn muốn tạo danh mục con của danh mục đã tạo là danh mục “Tài 

liệu tiếng Anh” thì các bạn lại có 2 cách để tạo 

Cách 1: Click vào Create new category, tại Parent category các bạn chọn “Tài liệu 

tiếng Anh” và đặt tên là “Tài liệu A” ➔Chọn Create category là các bạn đã tạo xong 

danh mục Tài liệu A là con của “Tài liệu tiếng Anh” 

 

Cách 2:  

Tìm chọn biểu tượng cài đặt từ danh mục “Tài liệu tiếng Anh” click vào và chọn 

Create new subcategory ➔ Đặt tên cho danh mục là “Tài liệu B” ➔ Create category là 

các bạn đã tạo xong danh mục Tài liệu B là cũng là con của “Tài liệu tiếng Anh” 

 

Các bạn chú ý để di chuyển vị trí của danh mục con, thì các bạn sử dụng biểu 

tượng mủi tên bên phải danh mục 

 

* Thêm giáo viên và phân quyền giáo viên 

Sau khi đã tạo xong danh mục, tại trang hiện tại chúng ta click vào biểu tượng cài 

đặt ➔ Assion roles là thêm vai trò giáo viên hoặc người quản lý, Permissions là phân 

quyền giáo viên hoặc người quản lý 
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* Đưa danh mục ra ngoài trang chủ 

Các bạn chọn Site administration ➔ Front page ➔ Front page settings 

 

Các bạn chú ý mục Front page và Front page items when logged in chọn Combo 

list sẽ dễ nhìn hơn, các phần còn lại chúng ta để mặc định ➔ chọn Save changes để 

hoàn tất. 

Các bạn trở lại trang chủ để kiểm tra lại danh mục đã hiển thị tại Trang chủ chưa. 

* Đưa bản tin ra ngoài trang chủ 

Di chuyển đến Site administration ➔ Font page ➔ Font page settings 

 

Tại đây mục Font page và Front page items when logged in chọn 

Announcements ở ô thứ 3 ➔ Click Save changes để hoàn tất thao tác. 
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Sau đó chúng ta trở lại trang chủ kiểm tra xem đã hiển thị bảng tin chưa, để viết 

và tạo bảng tin thì các bạn chọn Add a new topic ➔ copy tên và nội dung đã soạn sẵn 

➔ Click Post to forum à hoàn tất việc tạo bản tin trên trang chủ 

 

* Tạo khóa học trên Moodle 

Trước khi tạo khóa học trên Moodle thì chúng ta cần phải cài đặt khóa học mặc 

định với các bước như sau: 

Di chuyển đến Site administration ➔ Courses ➔ Course default settings. 

 

Tại đây thông thường các bạn chọn Hide (ẩn) để sau khi các bạn soạn xong khóa 

học rồi mới hiển thị. Mục Format thông thường mặc định là Topics format và tùy theo 

mục đích mà các bạn muốn chọn. Đến mục Show activity reports (xem các hoạt 

động) các bạn chọn Yes. Các mục còn lại để mặc định 
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Tiếp đến mục quan trọng là Files and uploads các bạn nên chọn tầm 500KB 

hoặc 1MB để tránh hao tốn dung lượng Host ➔ chọn Save changes để hoàn thành cài 

đặt cấu hình cho khóa học. 

* Tiến hành tạo Khóa học 

Tại trang chủ, các bạn chọn vào danh mục cần tạo khóa học➔ chọn Add new 

course 

 

Sau đó trình tự nhập thông tin cần thiết: 

- Tên khóa học 

- Tên viết tắt của khóa học 

- Chọn ẩn hay hiện khóa học 

- Chọn ngày bắt đầu và kết thúc 

Sau đó đưa nội dung vào khóa học Các mục khác chúng ta đã cài đặt mặc định 

rồi nên các bạn chỉ cần click Save and return là hoàn thành tạo khóa học. Để kiểm tra 

các bạn quay trở lại trang chủ. 



 

61 

 

Tuy nhiên tai trang chủ các bạn nhìn thấy Availabel courses có hiển thị khóa học 

và ở dưới cũng có nên bỏ hiển thị phần trên bằng cách: 

Di chuyển đến Site administration và Front page items when logged in ➔ Font 

page ➔ None ➔ Save changes 

 

Trở lại trang chủ các bạn thấy phần Availabel courses đã mất và chúng ta đã 

hoàn thành xong cách tạo khóa học trên Moodle. 

* Về Forum (diễn đàn) trên Moodle 

Đầu tiên, để cài đặt chung cho các Forum:  

 

Di chuyển đến Site administration ➔ Plugins ➔ Activiti Modules ➔ Forum 

Tại đây các bạn chú ý mục Display mode ➔ chọn Display replies flat, with oldest 

first (bài và bình luận bằng nhau, bài viết đăng trước sẽ ở trên cùng) 

- Discussions per page (các bình luận trên trang): chọn 20  
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- Maximum attachment size: chọn 100KB  

- Maximum number of attachment: chọn 3 

- Tất cả các mục còn lại để mặc định 

 

Chọn Save changes  

Như vậy chúng ta đã cài đặt xong cấu hình của diễn đàn 

Sau khi tạo 1 khóa học thì Moodle mặc định sẽ tự tạo 1 diễn đàn và thông thường 

Moodle không cho phép các bạn xóa diễn đàn đó. 

 

Để bỏ điễn đàn đó thì các bạn làm ẩn diễn đàn bằng cách: Click vào biểu tượng 

cây viết → chọn và delete hết nội dung, tiến đến gõ Space trên bàn phím và tiếp tục 

nhấn Enter, khi đó danh mục sẽ bị ẩn đi. 

* Tạo Forum trong các danh mục  

Chọn Turn editing on ➔ Tìm đến Danh mục mà các bạn muốn tạo Forum 

Trong Bài học các bạn chọn Add an activity or resource ➔ Forum và tiến hành đặt tên 

cho Forum. 

 

Thêm nội dung cho Description rồi chọn bật hay tắt tùy các bạn ➔ chọn Lưu và 

quay lại khóa học 
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Tiếp theo cũng tại Diễn đàn, chúng ta sẽ thực hiện thao tác di chuyển hoặc thay 

đổi vị trí các diển đàn bằng cách: giữ chuột trái tại biểu tượng mũi tên 4 hướng và di 

chuyển đến vị trí các bạn cần 

Chúng ta có thể đổi tên diễn đàn bằng cách click vào biểu tượng cây viết rồi đổi 

tên như mong muốn 

* Đề trắc nghiệm trên Moodle 

Đầu tiên chúng ta cần cài đặt mặc định cho đề thi như sau: 

Các bạn chọn Site administration ➔ Plugins ➔ chọn Activiti Modules ➔ chọn 

Quiz 

 

Hầu hết các mục tại đây nên để mặc định, chỉ thay đổi một số mục cần thiết, di 

chuyển xuống dưới cùng chọn Save changes để hoàn tất cài đặt mặc định cho đề thi 

* Tạo câu hỏi cho đề thi 

Đầu tiên các bạn chọn danh mục cụ thể mà chúng ta muốn cho đề thi ➔ tìm đến 

mục Question bank ➔ Import 
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Tại đây các bạn sẽ thực hiện 2 cách với định dạng Aiken format và GIFT format 

Để thực hiện chúng ta nên chuẩn bị soạn sẵn nội dung đề thi Aiken và GIFT 

Nội dung đề thi Aiken soạn sẵn có cấu trúc gồm: Câu hỏi, câu trả lời và đáp án – 

mỗi câu hỏi cách nhau 1 dòng trắng. Sau khi soạn xong thì các bạn save lại với dịnh 

dạng Plain Text bằng cách: 

Chọn File ➔ Save as ➔ chọn nơi muốn lưu ➔ chọn định dạng Plain Text ➔ chọn 

Save ➔ chọn Other encoding ➔ di chuyển mũi tên lên chọn Unicode (UTF 8) ➔ nhấn 

OK 

 

Để thêm vào chúng ta chọn Choose a file ➔ chọn tiệp có đuôi .txt ➔ chọn Open 

và Upload the file để hoàn tất 
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Cách thứ 2 đễ đưa file đề thi có đuôi .txt vào rất nhanh là chọn file và nhấn giữ 

chuột kéo đặt thả vào là xong 

Sau khi đã upload file, chúng ta chọn định dạng Aiken phía trên rồi chọn Import 

 

Danh bạ hiển thị màu xanh là công việc tạo câu hỏi thành công 

Bây giờ chúng ta sẽ tạo đề thi với định dạng GIFT format 

File đề thi trắc nghiệm dạng GIFT có cấu trúc gồm Câu hỏi, câu trả lời và câu có 

đáp án đúng sẽ được đánh dấu sao (*) đồng thời các câu hõi cách nhau 1 dòng trắng. 

Tại ứng dụng Word soạn nội dung đề thi, các bạn tìm đến View chọn Macros ➔ chọn 

View Macros 

 

Để tiếp tục thao tác chúng tôi đã chuẩn bị sẵn file có mã code và các bạn làm 

theo như sau (Xem video đính kèm) 

Copy MOODLE_GIFT dán vào Macro name ➔ chọn Create ➔ xuất hiện bảng code 

➔ xóa hết và trở lại file có mã code nhấn tổ hợp phím Ctrl A ➔ Copy và dán vào cửa sổ 

Norman NewMacros ➔ tiếp đến chọn save và đóng bảng lại 
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Tiếp tục các bạn lại chọn Macros ➔ chọn View Macros ➔ chọn MOODLE_GIFT ➔ 

chọn Run thì lúc này các câu hỏi sẽ được tự động tạo cấu hình theo cấu hình của 

Moodle cần khi đưa vào ngân hàng câu hỏi 

Tiếp theo các bạn chọn File ➔ Save as vào thư mục muốn lưu với định dạng Plain 

Text ➔ sau đó Save và tiếp tục chọn Other encoding ➔ di chuyển mũi tên lên chọn 

Unicode (UTF 8) ➔ chọn OK 

Quay lại trang của Moodle các bạn chọn GIFT Format ➔ Chọn Chose File ➔ chọn 

tiệp ➔ chọn file gift.txt ➔ chọn Open ➔ Upload this file ➔ Chọn Import 

 

Chúng ta đã hoàn thành xong tạo bài thi trắc nghiệm trên Moodle 

* Tạo tài khoản cho Giáo viên và học sinh 

Đầu tiên các bạn tìm đến Site administration ➔ chọn User ➔ chọn Accounts ➔ 

chọn tiếp Add a new user 
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Ở đây các bạn tạo riêng từng tài khoản: Đặt tên User, đặt password gồm 8 ký tự 

(có chữ thường, chữ in hoa, ký tự đặc biệt và chữ số) ➔ nhập tiếp thông tin người đăng 

ký và có thể upload avarta của người đăng ký ➔ cuối cùng chọn Create user là các bạn 

đã tạo xong một User hoàn chỉnh 

 

Tạo User hàng hoạt khi chúng ta đã có sẵn danh sách các Giáo viên hoặc học sinh 

Các bạn thực hiện như sau:  

Vào đến Site administration ➔ chọn User ➔ chọn Accounts ➔ chọn tiếp Upload 

users 

 

Tại đây Moodle cung cấm sẵn cho chúng ta file .csv (chúng ta sẽ tãi về xem và 

làm theo) 

Sau khi tải các bạn mở file xem và điều chỉnh danh sách theo thứ tự như file mẫu 

Trở lại trang của Moodle ➔ chọn Choose a file ➔ chọn tiệp ➔ open file ➔ chọn 

Upload this file ➔ kế đến chọn Upload user là hoàn thành 
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Tại trang Preview, mục Setting các bạn cần chọn Gửi mật khẩu qua email, các 

mục khác các bạn để mặc định và tiếp tục chọn Upload user ➔ chọn Continiue để 

hoàn thành việc tạo nhiều user cùng lúc 

* Thêm giáo viên cũng như thêm học sinh vào lớp học 

Đầu tiên các bạn chọn khóa học cụ thể để thêm giáo viên hoặc học sinh vào đó  

VD chọn khóa bài 1: Giao tiếp ở trường 

Tiếp đến tìm đến Administration phía dưới bên trái ➔ chọn User ➔ chọn Enrolled 

user 

 

Tại khóa học này hiện tại chưa có giáo viên và học sinh, để thêm Giáo viên hoặc 

Học sinh thì các bạn chọn Enrol user bên phải phía trên ➔ tiếp tục các bạn tìm và chọn 

Giáo viên ➔ tạo chức danh ➔ chọn Enrol user 
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Trình tự các bạn tiếp tục thêm học sinh vào lớp 

Như vậy các bạn đã hoàn thành việc tạo và tài khoản và đưa tài hoản vào lớp - 

khóa học 

* Tạo Mã xác nhận (Captcha)  

Các bạn tìm đến Site administration ➔ Plugins ➔ Authentication ➔ Manage 

authentication  

 

Tại đây các bạn di chuyển xuối dưới tìm mục ReCAPTCHA site key và chọn Google 

CAPTCHA bên góc phải. 

 

Ở đây các bạn nên đăng nhập sẵng tài khoản gmail trước và chọn Admin 

Console  

Sau đó các bạn nhập tên miền các bạn muốn tạo mã ➔ tiếp theo chọn phiên bản 

reCAPTCHA version 2 và chọn luôn I’m not robot” checkbox ➔ dán tên miền đã copy 

vào Areas ➔ chọn Accept the reCAPTCHA terms of use ➔ click TO SEND thì các bạn 

sẽ nhìn thấy chúng ta có 2 mã code 
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Các bạn copy mã code mục COPY SITE KEY đưa qua trang của Moodle và dán 

vào mục ReCAPTCHA site key 

 

Tiếp tục các bạn lại trở về copy mã code mục COPY THE SECRET KEY đưa qua 

và lại dán vào mục ReCAPTCHA secret key 

Bấm Save Changes là các bạn đã tạo được mã xác nhận 

Và để bật mã xác nhận thì các bạn cần làm thêm 1 thao tác nữa là:  

Các bạn tìm chọn mục Email-based seft-registration → tại đây các bạn chọn Yes 

từ mục Enable ReCAPTCHA element → di chuyển xuống cuối chọn Save changes là 

các bạn đã hoàn thành tạo và bật mã xác nhận cho web với tên miền của minh trên 

Moodle 

 

Các bạn có thể trở về trang chủ để kiểm tra lại bằng cách: Log out và ra lại trang 

chủ ➔ chọn Create new account ➔ di chuyển xuống các bạn sẽ thấy phần Captcha đã 

hiển thị 

Như vậy các bạn đã hoàn thành thao tác hoàn chỉnh. 

* Di chuyển diễn đàn và di chuyển đề thi từ diễn đàn này sang diễn đàn khác  
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Ví dụ cụ thể chúng ta sẽ di chuyển “Thảo luận bài 1” trong Bài 1: Giao tiếp ở 

trường sang “Bài 2: Giao tiếp cùng bạn”  

Để làm được điều trên, trước tiên chúng ta cần cài đặt 1 Plugin, thực hiện như 

sau: 

Đầu tiên các bạn tìm chọn Site administration ➔ chọn Plugins ➔ chọn Install 

Plugins 

Các bạn chọn và giữ chuột kéo vào ô Choose a file ➔ Install plugin from the zip 

file ➔ chọn Continue ➔ tiếp tục kéo xuống dưới chọn tiếp Continue ➔ chọn Upgrade 

Moodle database now ➔ Continue ➔ Save changes. 

Chúng ta lại quay lại khóa học bằng cách chọn Courses bên trái màn hình 

Chọn vào khóa “Tiếng Anh Giao Tiếp” vào “Bài 1: Giao tiếp ở trường” tại đây các 

bạn chọn Turn editing on và di chuyển xuống bên trái phía dưới màn hình chọn vào ô 

Add... rồi tìm chọn Sharing Cart 

 

Từ đây các bạn nhìn bên phải của bài Thảo luận bài 1 chọn vào biểu tượng cái 

giỏ và tiếp tục chọn Confirm 

 

Khi đó bên trái phía dưới sẽ xuất hiện ô Sharing Cart với bài “Thảo luận bài 1” 

Tiếp tục các bạn trổ lại khóa học “Tiếng Anh Giao Tiếp” chọn “Bài 2: Giao tiếp 

cùng bạn” 

Các bạn lại chọn Add ➔ chọn Sharing Cart 
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Từ ô Sharing Cart tìm chọn biểu tượng coppy và di chuyển lên trên để chúng ta có 

thể dán vào vị trí mình mong muốn 

 

Ví dụ chọn “Hỗ trợ thảo luận bài 2” các bạn click vào dấu mũi tên 

 

Các bạn chọn Turn editing on để vào kiểm tra lại thao tác mình vừa thực hiện đã 

như mong muốn 

 

Hướng dẫn sử dụng Moodle: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

moodle 

 

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-moodle
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-moodle
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 2. Xây dựng hệ thống LMS bằng Blackboard 

2.1. Giới thiệu về Blackboard 

Blackboard được thành lập năm 1997, trụ sở chính ở Washington DC và các chi 

nhánh tại Bắc Mỹ, Châu Âu, Châu Á và Úc. 

Từ năm 1997, Blackboard là công ty đứng đầu toàn cầu cung cấp các giải pháp 

về đổi mới và sáng tạo công nghệ, hỗ trợ cải thiện kinh nghiệm học tập của hơn 180 

triệu học sinh, sinh viên và học viên trên toàn thế giới mỗi ngày. 

Blackboard hiểu rằng mỗi tổ chức, mỗi quốc gia đều có những chiến lược riêng. 

Để đáp ứng những yêu cầu này, Blackboard có đội ngũ chuyên gia với hơn 2000 giáo 

sư và kỹ sư, những người có những kinh nghiệm dày dặn, đã từng làm việc trực tiếp ở 

các trường đại học danh tiếng hàng đầu trên thế giới. Hiện nay, hơn 72% các trường đại 

học đứng hàng đầu trên thế giới sử dụng giải pháp quản lý do Blackboard cung cấp. 

Với các trường phổ thông từ mầm non đến trung học phổ thông ở Mỹ, 49/50 

trường đang sử dụng hệ thống của Blackboard. Nền tảng sản phẩm của Blackboard 

được phát triển và triển khai từ giáo dục phổ thông, giáo dục đại học, giáo dục sau đại 

học và các đơn vị doanh nghiệp cũng như các dự án chính phủ, các tập đoàn đa quốc 

gia áp dụng mô hình đào tạo số, ứng dụng việc dạy và học trực tuyến, triển khai thành 

công mô hình đào tạo tích hợp mô hình lớp học truyền thống và lớp học kết hợp 

(blended learning), lớp học đảo ngược (flipped classroom), lớp học ảo (virtual class),… 

Bên cạnh đó, Blackboard tích hợp với nội dung cơ sở dữ liệu giảng dạy và nghiên cứu 

khoa học đã được chuẩn hóa trong hệ thống với hàng ngàn công cụ mở hỗ trợ công 

tác quản lý và nâng cao hiệu quả đào tạo. 

Blackboard cung cấp hệ thống giáo dục công cụ đánh giá chuẩn đầu ra của 

người học nhằm hỗ trợ các cơ sở giáo dục đào tạo trong việc triển khai công tác kiểm 

định chất lượng chương trình đào tạo. 

Blackboard cung cấp giải pháp học công nghệ một cách toàn diện và tối ưu hóa 

các nguồn lực để cải thiện những hạn chế trong giải pháp học với mức chi phí hoàn 

toàn hợp lý. 

Giáo dục 4.0 với nền tảng của Blackboard đáp ứng các yêu cầu về giải pháp giảng 

dạy & học tập và công nghệ, bao gồm: 

- Hoạt động trên các thiết bị điện tử, điện thoại thông minh. 

- Đồng bộ hóa những lớp học online & offline. 

- Tích hợp với những nguồn nội dung kĩ thuật số hàng đầu. 

- Đánh giá sự tiến bộ của người học, giảng viên, đánh giá trên từng cấp độ quản 

lý. 

- Phân tích và báo cáo chuẩn đầu ra. 

- Chuyển giao công nghệ giảng dạy mô hình giáo dục đào tạo 4.0 nhằm chuyên 

môn hóa các hoạt động chuyên môn của giảng viên, bộ phận quản lý và gia tăng hiệu 

quả việc giảng dạy và học tập. 
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2.2. Hướng dẫn một số thao tác cơ bản trên Blackboard 

* Cách tạo một bài Test trong Blackboard 

Để tạo một bài kiểm tra mới giáo viên cần thực hiện hai bước. 

1. Tạo bài kiểm tra. Tùy chỉnh các tùy chọn theo ý giáo viên. 

2. Thêm các câu hỏi vào bài kiểm tra. 

TẠO BÀI KIỂM TRA 

Các bước trong Snap: Create learning activity or resource > Quiz > Add 

 

 

- Nhập tên và phần nội dung cho bài kiểm tra. 

+ Tên bài kiểm tra xuất hiện trên trang khóa học theo mặc định. 

+ Chọn “Hiển thị mô tả ở trang khóa học” nếu giáo viên muốn phần nội dung xuất 

hiện. 

- Chỉnh sửa các các tùy chọn để thay đổi giao diện, layout hoặc chức năng của bài 

kiểm tra. 

- Click vào “Lưu và trở về khóa học” để hiển thị trang ban đầu của khóa học hoặc 

“Lưu và cho xem” để hiển thị bài kiểm tra. 

CHỈNH SỬA BÀI KIỂM TRA 
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Các bước trong Snap: Quiz > Edit 

 

Để chỉnh sửa bài kiểm tra, hãy di chuyển đến bài kiểm tra và chọn “Chỉnh sửa”. 

TÙY CHỈNH THỜI GIAN 

Các bước trong Snap: Quiz > Edit > Timing 

Tùy chỉnh thời gian cho phép giáo viên quyết định thời gian làm bài kiểm tra của 

học sinh. 

 - Mở bài kiểm tra: Chọn ngày giờ cụ thể để học sinh có thể bắt đầu làm bài kiểm 

tra. Theo mặc định, bài kiểm tra sẽ mở vào ngày giáo viên tạo bài kiểm tra. 

 - Đóng bài kiểm tra: Chọn ngày giờ cụ thể để kết thúc bài kiểm tra và ẩn nó để 

học sinh không nhìn thấy. Kỳ hạn nên sau ngày được đặt để mở bài kiểm tra. 

- Thời gian làm bài: Tùy chọn này xác định thời gian học sinh phải hoàn thành bài 

kiểm tra. 

- When time expires: Có 3 tùy chỉnh 

+ Open attempts are automatically submitted (Bài kiểm tra tự động được nộp): Tự 

động nộp mặc dù các câu hỏi trong bài kiểm tra vẫn chưa được lưu. 

+ There is a grace period (Gia hạn thời gian nộp): Cho phép gia hạn thêm thời gian 

trước khi một bài kiểm tra được nộp. Nhập số phút được phép trong gia hạn nộp. 

+ Attempts must be submitted before time expires (Bài kiểm tra phải được nộp 

trước khi hết thời gian): Học sinh phải nộp bài kiểm tra của mình trước khi hết thời gian. 

Nếu học sinh không nộp bài kiểm tra trong khoảng thời gian đó thì bài kiểm không 

được tính. 

- Phương pháp chấm điểm: Chọn phương pháp chấm điểm được sử dụng để 

chấm điểm bài kiểm tra. Chọn từ Điểm cao nhất, Điểm trung bình, Lần làm bài đầu tiên 

hoặc Lần làm bài cuối cùng. 

ĐIỂM 

Các bước trong Snap: Quiz > Edit > Grade 

Tùy chỉnh số lần làm bài, phương pháp tính toán và những gì học sinh cần để 

vượt qua bài kiểm tra. 

 - Chuyên mục điểm: Chọn danh mục số điểm giáo viên muốn nhóm bài kiểm tra. 

- Điểm để vượt qua: Nhập số điểm tối thiểu phải vượt qua. 

- Số lần làm bài cho phép: Chọn số lần học sinh có thể làm bài kiểm tra. 

- Cách tính điểm: Chọn cách giáo viên muốn tính điểm cho bài kiểm tra. 

+ Điểm cao nhất: Điểm cuối cùng là điểm cao nhất đạt được trong tất cả các lần 
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làm bài. 

+ Điểm trung bình: Điểm cuối cùng là điểm trung bình của tất cả các điểm đạt 

được trong tất cả các lần làm bài. 

+ Lần làm bài đầu tiên: Điểm cuối cùng là điểm đạt được trong lần làm bài đầu 

tiên. 

+ Lần làm bài cuối cùng: Điểm cuối cùng là điểm đạt được trong lần làm bài cuối 

cùng. 

LAYOUT 

Các bước trong Snap: Quiz > Edit > Layout 

Tùy chỉnh bao nhiêu câu hỏi học sinh nhìn thấy tại một thời điểm và thứ tự họ có 

thể trả lời chúng. 

- New page (Trang mới): Chọn số lượng câu hỏi giáo viên muốn xuất hiện trên 

mỗi trang. 

- Navigation method (Phương pháp điều chỉnh): Chọn “Sequential” để buộc học 

sinh trả lời các câu hỏi theo thứ tự được trình bày. Chọn “Free”, nếu học sinh có thể trả 

lời các câu hỏi theo bất kỳ thứ tự nào. 

QUESTION BEHAVIOR 

Các bước trong Snap: Quiz > Edit > Question behavior 

Chọn cách học sinh tương tác với các câu hỏi trong bài kiểm tra. 

Ví dụ: Cho học sinh trả lời tất cả các câu hỏi kiểm tra trước khi nhận được điểm 

hoặc phản hồi. Xáo trộn thứ tự các câu hỏi kiểm tra. Cung cấp gợi ý cho học sinh trước 

khi làm bài. 

Mở rộng trạng thái câu hỏi và tùy chỉnh như sau. 

Thay đổi vị trí đáp án trong các câu hỏi: Thay đổi vị trí đáp án trong các câu hỏi 

mỗi khi học sinh làm bài kiểm tra. Cài đặt này chỉ áp dụng cho các câu hỏi có nhiều 

đáp án, chẳng hạn như câu hỏi trắc nghiệm hoặc câu hỏi matching. 

Hành vi của các câu hỏi: Học sinh có thể tương tác với câu hỏi trong bài kiểm tra 

theo nhiều cách khác nhau. Ví dụ: Giáo viên muốn học sinh nhập câu trả lời cho từng 

câu hỏi và rồi nộp cả bài kiểm tra, trước khi được chấm điểm hoặc nhận phản hồi. Đó là 

chế độ “Phản hồi hoãn”. 

Hay giáo viên muốn học sinh nộp từng câu hỏi khi gặp để nhận phản hồi trực tiếp 

và nếu không đúng thì sẽ có thêm lần thử khác với số điểm ít hơn. Đó sẽ là chế độ 

“Tương tác với nhiều lần thử”. 

Allow redo within an attempt: Cho phép học sinh làm lại câu hỏi trước khi học 

sinh hoàn thành bài tập. Sử dụng tùy chọn này cho các bài kiểm tra thực hành. Tùy 

chỉnh này hoạt động tốt nhất với các hành vi câu hỏi như “Immediate feedback” or 

“Interactive with multiple tries”. 

Each attempt builds on the last: Cho phép các lần làm bài trắc nghiệm mới bao 

gồm kết quả của lần làm bài trước. Điều này cho phép học sinh có thêm một số lần 
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làm bài nữa để hoàn thành một bài kiểm tra. 

REVIEW OPTIONS 

Các bước trong Snap: Quiz > Edit > Review options 

Kiểm soát những thông tin của học sinh khi giáo viên xem xét một bài kiểm tra 

hoặc xem các báo cáo bài kiểm tra. Ví dụ: giáo viên có thể kiểm soát nếu giáo viên thấy 

phản hồi chung, điểm của học sinh và câu trả lời đúng. 

Chọn những gì giáo viên muốn học sinh nhìn thấy trong mỗi khoảng thời gian sau 

đây. 

During the attempt: Cho phép học sinh xem thông tin đã chọn trong khi học sinh 

đang trả lời câu hỏi. Tùy chỉnh này chỉ liên quan đến một số hành vi câu hỏi. Ví dụ: Với 

“Interactive with multiple tries”, hiển thị phản hồi trong khi thử bài kiểm tra. 

Immediately after the attempt: Cho phép học sinh xem thông tin đã chọn ngay 

sau khi làm bài kiểm tra. Tùy chỉnh này áp dụng trong hai phút đầu tiên sau khi học 

sinh chọn “Submit all and finish”. 

Later, while the quiz is still open: Cho phép học sinh xem thông tin đã chọn sau 

đó, trong khi bài kiểm tra vẫn mở. Học sinh phải xem thông tin trước khi ngày thi gần 

hết. 

After the quiz is closed: Cho phép học sinh xem thông tin đã chọn sau khi ngày 

kết thúc bài kiểm tra đã qua. 

GIAO DIỆN 

Các bước trong Snap: Quiz > Edit > Appearance 

Tùy chỉnh giao diện cho phép giáo viên xem hình ảnh của học sinh xuất hiện trên 

màn hình trong khi làm bài kiểm tra hay không và cũng chỉ định số lượng vị trí thập 

phân được sử dụng khi hiển thị điểm. 

Show the user's picture: Hiển thị hình ảnh của học sinh trong khi đang làm bài 

kiểm tra. Điều này ngăn chặn một số học sinh gian lận trong bài kiểm tra. 

Decimal places in grades: Chọn bao nhiêu chữ số sẽ xuất hiện sau dấu thập 

phân cho các điểm số. Tùy chỉnh này chỉ ảnh hưởng đến cách xuất hiện các điểm số. 

Nó không thay đổi cách tính toán điểm. 

Decimal places in question grades: Chọn bao nhiêu chữ số sẽ xuất hiện sau dấu 

thập phân trong các điểm số. 

Show blocks during quiz attempts*: Hiển thị các khối khóa học bình thường trong 

các lần làm bài bài kiểm tra. 

EXTRA RESTRICTIONS ON ATTEMPTS 

Các bước trong Snap: Quiz > Edit > Extra restrictions on attempts 

Khóa một bài kiểm tra để ngăn cản học sinh gian lận. 

Yêu cầu mật khẩu: Nhập mật khẩu học sinh phải sử dụng để truy cập vào bài 

kiểm tra. Chọn Unmask để xem mật khẩu khi giáo viên nhập nó. 
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Yêu cầu địa chỉ mạng: Hạn chế bài kiểm tra này chỉ cho những người ở một địa 

điểm nhất định. Nhập danh sách các số địa chỉ IP một phần hoặc toàn bộ được phân 

tách bằng dấu phẩy. 

Enforced delay between 1st and 2nd attempts: Học sinh chờ đợi trước khi thực 

hiện lần làm bài thứ hai trong bài kiểm tra. Chọn “Mở”. Nhập một số và chọn khoảng 

thời gian mong muốn từ menu thả xuống. 

Enforced delay between later attempts: Học sinh chờ đợi trước khi thực hiện 

thêm lần làm bài nữa. 

Browser security *: Bài kiểm tra bắt đầu nếu học sinh có trình duyệt web hỗ trợ 

JavaScript. Điều này ngăn các cửa sổ khác xuất hiện trên máy tính của học sinh trong 

bài kiểm tra. Học sinh cũng không thể sử dụng bản sao và dán trong bài kiểm tra. 

PHẢN HỒI CHUNG 

Các bước trong Snap: Quiz > Edit > Overall feedback 

Nói một vài điều với học sinh khi học sinh nộp một bài kiểm tra. Giáo viên có thể 

thay đổi tin nhắn tùy thuộc vào điểm của học sinh. 

Điều này được thực hiện với cột mốc điểm. cột mốc điểm tạo ra phạm vi điểm. 

100% và 0% tồn tại theo mặc định. Giáo viên có thể tạo bất kỳ số lượng cột mốc giữa 

100 và 0%. Nhập cột mốc điểm dưới dạng phần trăm hoặc số. 

Với mỗi cột mốc là một khu vực để giáo viên nhập tin nhắn của mình. Học sinh 

thấy thông báo này khi điểm số của họ rơi vào giữa các cột mốc. Nhập tin nhắn giáo 

viên muốn học sinh xem nếu họ ghi điểm trong phạm vi đó. 

Thí dụ: 

Cột mốc điểm: 100% Phản hồi: Làm tốt lắm! Cột mốc điểm: 60% 

Phản hồi: Vui lòng học bài học tuần này nhiều hơn. 

Những học sinh đạt điểm từ 100% đến 60% sẽ thấy, "Làm tốt lắm!". Những học 

sinh đạt điểm từ 59,99% đến 0% sẽ thấy, "Vui lòng học lại trong tuần này". 

* Cách tạo diễn đàn Hội thảo trong Blackboard 

Với công cụ Discussion Board các thành viên của khóa học có thể tạo ra các 

cuộc thảo luận sôi nổi như trong lớp học truyền thống. Điều đó rất quan trọng để lập kế 

hoạch và tạo nội dung cho khóa học, các bạn cần phải cung cấp dàn ý cho các cuộc 

thảo luận trực tuyến. 

Hướng dẫn này sẽ cho bạn thấy làm thế nào để truy cập vào các diễn đàn thảo 

luận, tạo diễn đàn, chọn các thiết lập phù hợp với nhu cầu, và sắp xếp lại các forum 

trong diễn đàn thảo luận. 
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Một Discussion Board Forum là nơi người tham gia, thảo luận về một chủ đề 

hoặc một nhóm các chủ đề liên quan. 

Trong mỗi diễn đàn, người dùng có thể tạo nhiều chủ đề. Một chủ đề bao gồm 

các bài ban đầu và các bình luận của nó. Bạn có thể truy cập vào Discussion Board 

của khóa học từ Control Panel bằng cách mở rộng Course Tool. 

 

Các Discussion Board thường được truy cập từ menu khóa học. Tuy nhiên, bạn 

có thể cung cấp một liên kết đến các Discussion Board của khóa học hoặc một forum 

cụ thể trong một lĩnh vực. 

 

Điều này cho phép sinh viên truy cập vào các cuộc thảo luận cùng với nội dung 

khóa học. 
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Trang Discussion Board ➔ click Create Forum ➔ gõ một cái tên, gõ hướng dẫn 

hoặc mô tả trong Description Box 

 

Trong phần Forum Avallabillty chọn Yes để nó hiện lên cho người dùng 

 

Để thiết lập giới hạn thời gian, bạn có thể đặt forum hiển thị vào ngày, giờ cụ thể 

và ngừng hiển thị vào một thời điểm cụ thể. Giới hạn này không ảnh hưởng đến việc 

hiển thị forum trừ khi đến thời điểm 

 

Chọn Grade Discussion Forum và gõ mức điểm để đánh giá người tham gia qua 

hoạt động trên forum. Chọn Grade Thread để đánh giá người tham gia qua hoạt động 

trong mỗi chủ đề. Ví dụ, chúng ta sẽ tạo ra một forum có mức điểm là 50 . 

 

Khi việc chấm điểm được kích hoạt, bạn có thể chọn một ngày kết thúc. 
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Thời hạn dùng để tổ chức và phân chia các tiêu chí để chấm điểm các giai đoạn 

trong Grade Center. Thông báo điểm số sẽ hiển thị sau ngày kết thúc thời hạn. 

Tùy chọn thêm một bảng đánh giá bằng cách chọn Add Rubric ➔ nhấn Submit. 

Trên trang Discussion Board một forum mới xuất hiện ở dưới cùng của danh sách. 

 

* Cách tạo ra những thông báo trong khóa học 

Chúng ta có thể sử dụng công cụ thông báo để nhắc nhở sinh viên về các sự kiện 

hoặc thông tin thời gian quan trọng khác. Trong thông báo của bạn, có thể bao gồm 

văn bản, hình ảnh và đa phương tiện, cũng như các liên kết đến nội dung khóa học. 

Đầu tiên, vào Announcements trong Control Panel 

 

Gõ chủ đề sẽ trở thành tiêu đề của thông báo trên trang Announcements, các 

bạn cũng có thể sử dụng các chức năng trong trình soạn thảo nội dung để định dạng 

văn bản và thêm hình ảnh, đa phương tiện, và mashup. 

 

Trong phần Web Announcement Options, chọn Date Restricted ➔ Display After 

và Display Until, và chọn ngày và giờ cụ thể 

Chọn Send a copy of the announcement immediately nếu bạn muốn gửi email 

cho sinh viên có chứa các thông báo. 



82 

 

Trong phần Course Links, bấm Browse để tạo ra một liên kết từ các thông báo 

đến một mục của khóa học ➔ Chọn Course Item từ bảng pop-up của khỏa học ➔ Chọn 

Submit 

 

Thông báo mới xuất hiện trực tiếp bên dưới thanh tiêu đề và có thể dịch chuyển. 

Thông báo gần nhất sẽ xuất hiện đầu tiên 

 

* Cách thêm nội dung vào Module học 

Bạn có thể thêm tài liệu học tập và các hoạt động liên quan đến các mô-đun học 

tập và sau đó quản lý chúng như bạn quản lý các mục trong một mục lục. 

Bắt đầu các bạn chọn Lessons ➔ Chọn Module cần tạo  
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Các bạn có thể thêm nội dung vào mô-đun học tập của bạn bằng cách sử dụng 

các chức năng trên thanh hành động. Bạn có thể thêm nhiều loại nội dung vào mô-đun 

học tập như các tập tin, hình ảnh, và weblinks 

 

Trên trang Create Item, gõ một tên ngắn gọn, và thêm một mô tả, hướng dẫn hoặc 

thông tin. 

 

Thêm nội dung vào mục Text, bạn có thể kết hợp nhiều loại như văn bản, hình 

ảnh, liên kết, đa phương tiện, mashup, và file đính kèm, và xác định nơi chúng xuất hiện 

trong văn bản của bạn. Bây giờ, thiết lập các tùy chọn để xem các nội dung ví dụ như 

cách hiển thị một mục có sẵn cho người dùng, theo dõi số lần xem, và chọn hạn chế 

ngày và thời gian. 

Sau khi nhập đẩy đủ các thông tin cần thiết chọn Submit. Các mục mới sẽ xuất 

hiện ở dưới cùng của trang, và trong bảng mục lục. 
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* Cách bật và tắt các công cụ trong khóa học 

Bắt đầu truy cập vào Control Panel ➔ Customization ➔ Tool Availability 

 

Chọn hoặc bỏ chọn hộp kiểm của các công cụ bạn muốn sử dụng trong khóa học 

của mình, và xác định người dùng sẽ được tiếp cận với những công cụ này. 

 

Cột có chứa một vòng tròn với một đường chéo có nghĩa là tổ chức của bạn làm 

công cụ này không có sẵn, hoặc nó không có sẵn trong hệ thống. 

- Nếu bạn chọn cột Available, công cụ sẽ có sẵn trong khóa học của bạn và mở 

cho tất cả những người dùng có vai trò, được cho phép sử dụng công cụ này. 

- Nếu bạn chọn Visible to Guests hoặc Visible to Observers, họ có thể nhìn thấy 

công cụ này, nhưng nếu bạn cho phép khách và các quan sát viên trong khóa học của 

bạn, họ có thể không sử dụng nó. 
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- Nếu bạn chọn Available in Content Area, bạn có thể đặt liên kết đến một công 

cụ trong một hay nhiều nội dung trong khóa học của bạn. Bạn có thể lọc danh sách 

các công cụ để dễ dàng xem những công cụ nào có sẵn.  

Nhấn vào Filter trên thanh hành động để sắp xếp bảng với các tùy chọn trong 

danh sách được thả xuống. 

 

* Cách thêm đường link công cụ vào trong khóa học 

Để bắt đầu, thay đổi Edit Mode sang On bên trái trên màn hình 

 

Tiếp tục chọn dấu cộng (+) trên Course Menu ➔ Menu Item ➔ Tool Link 

 

Tại ô Add Tool Link nhập tên ngắn gọn ➔ chọn loại công cụ để tìm kiếm ➔ 

Submit Các Tool Link mới xuất hiện trên Course Menu ở cuối danh sách. Bạn có thể 

sắp xếp lại các liên kết trên Course Menu. 

Để thêm đường Link công cụ vào trong khóa học các bạn chọn Khóa học cần 

thêm chọn Assignment ➔ Tool ➔ Chọn công cụ để thêm (ví dụ: Blog) 
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Trong ví dụ này, chúng tôi sẽ chọn liên kết đến một blog tên là Planets Blog. Nhấn 

Next để tiếp tục tạo ra các Tool Link. 

 

Trên trang Create Link, gõ một cái tên. Tùy chọn, nhập một mô tả trong hộp kiểm, 

có thể sử dụng các chức năng biên tập nội dung để định dạng văn bản và bao gồm tệp, 

hình ảnh, liên kết web, đa phương tiện, và mashups. Chọn các tùy chọn mà bạn cần và 

chọn Submit 

 

 

 

Hướng dẫn sử dụng Blackboard: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

blackboard 

 

  

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-blackboard
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-blackboard
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 3. Xây dựng hệ thống LMS bằng Canvas 

3.1. Giới thiệu hệ thống quản lí học tập Canvas 

Canvas là hệ thống quản lý học tập trực tuyến được cung cấp bởi công ty công 

nghệ và giáo dục Instructure. Canvas được xây dựng dựa trên web và Canvas network 

- một nền tảng khóa học trực tuyến lớn. Từ năm 2015, Canvas ngày càng phát triển 

mạnh mẽ, khiến các “ông lớn” như Blackboard và Moodle phải dè chừng. Đặc biệt hơn, 

hệ thống này còn có thể dùng cho người khiếm thị. 

Instructure là một công ty công nghệ giáo dục có trụ sở tại thành phố Salt Lake, 

tiểu bang Utah miền Tây Hoa Kỳ. Instructure là nhà phát triển hệ thống quản lý học tập 

Canvas. Canvas instructure là ứng dụng hiện nay được rất nhiều trường đại học lựa 

chọn do tính năng tuyệt vời là có thể kết nối với các mạng tương tác khác như 

youtube.com, facebook.com. Canvas có giao diện khá giống với Moodle, cung cấp tài 

khoản có phí sử dụng. Dù miễn phí nhưng tài khoản dạng Free for Teacher cũng đã có 

đủ nhiều tính năng tuyệt vời hỗ trợ cho việc giảng dạy của giảng viên.. Instructure cũng 

phát triển Canvas network (là một nền tảng mở khóa học trực tuyến lớn)..  

Canvas được xây dựng bằng cách sử dụng ngôn ngữ Ruby on Rails như khuôn 

khổ ứng dụng web được hỗ trợ bởi một cơ sở dữ liệu PostgreSQL. Nó kết hợp JQuery, 

HTML5, CSS3 và để cung cấp một giao diện người dùng hiện đại. OAuth được sử dụng 

để cung cấp truy cập hạn chế thông tin của người dùng trên một số trang web truyền 

thông xã hội như Facebook và Twitter để cho phép sự hợp tác giữa các trang web. 

Canvas hoạt động như một phần mềm hay một dịch vụ sử dụng Amazon Web 

Services trong " đám mây". Vậy có thể hiểu : Canvas là phần mềm nguồn mở mới, nó 

dùng để quản lý hệ thống học tập trong cuộc cách mạng hóa giáo dục, dễ học, dễ sử 

dụng. 

3.2. Hướng dẫn sử dụng Canvas 

* Tạo tài khoản 

Bước 1: Giảng viên cần tạo tài khoản tại Canvas trước khi có thể truy cập và xây 

dựng bài giảng của mình trong Canvas. Để tạo tài khoản miễn phí, giảng viên truy cập 

vào trang https://canvas.instructure.com/register và chọn lập dạng tài khoản Free for 

Teacher bằng cách nhấn vào ô màu xanh nước biển “I’M A TEACHER”. 

https://canvas.instructure.com/register
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Tại trang truy cập này, người sử dụng cũng có thể đăng ký lập tài khoản sinh viên 

hoặc tài khoản cha mẹ nếu người đó có con đang theo học các khóa học trong Canvas 

và mong muốn theo dõi lớp học của con, theo dõi việc học tập của con. 

Bước 2: Tại trang truy cập sau khi click, giảng viên điền đầy đủ thông tin cá nhân 

rồi chọn “NEXT” 

 

Bước 3: Sau đó tạo mật khẩu để tiếp tục. Mật khẩu phải có ít nhất 8 ký tự, sau đó 

chọn “SUBMIT” để hoàn thành. 
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Bước 4: Xác nhận đăng kí bằng cách nhấn vào đường link trong Email xác nhận 

được gửi về và đăng nhập với thông tin Gmail và Password ➔ Log in 

 

 
Giao diện Canvas sau khi đăng nhập 

SỬ DỤNG CÁC TÍNH NĂNG CỦA CANVAS 

* Tạo khóa học 

Tại giao diện, chọn Dashboard ➔ Start a new course tại góc trái phía trên của 

giao diện và cửa sổ sẽ hiện ra như hình phía dưới, cho phép người sử dụng đặt tên cho 

khóa học mới ➔ Chọn Create course để hoàn tất 
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* Tạo mô-đun (Modules) 

Mô đun (Modules) là nơi tập trung toàn bộ nội dung của 1 khóa học, bao gồm tài 

liệu bài giảng, các bài tập thực hành (có thể nộp bài và chấm điểm), các bài tập trắc 

nghiệm, các thảo luận trực tuyến được sắp xếp theo trình tự của một Module học tập, 

có thể sắp xếp theo buổi học, theo tuần học, hoặc theo nhu cầu giảng dạy của giảng 

viên. 

Để thêm Modules, giảng viên chọn +Module ở góc phải trên màn hình 

 

Sau đó nhập tên Module tại ô Module name, ở phần này các bạn có thể chọn lịch 

học cho Module. Ví dụ: Module name: Bảng IPA; Unlock At: August 26, 2020. 
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Giảng viên có thể tùy biến các mô-đun này theo đặc thù chuyên môn khóa học 

của mình. Trong từng mô-đun giảng viên có thể bổ sung thêm mục như Tập tin, Bài 

tập, Đề kiểm tra (Khảo sát), Liên kết ngoài URL, Audio. 

* Thêm nội dung khóa học 

Để có thể thêm các mục trên vào Module khóa học, trước hết giảng viên cần tạo 

hoặc tải các tài nguyên lên khóa học. 

Đầu tiên tại Trang chủ chọn Course ➔ File ➔ Chọn Module cần thêm nội dung ➔ 

Chọn Upload ➔ Chọn tệp nội dung cần thêm. 

 

Hoặc các bạn có thể chọn kí hiệu (+) bên phải tên Module và chọn dạng thông tin 

cần đưa vào (File) ➔ Chọn tệp và chọn Add Iterm để hoàn tất. 
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 Sauk hi thêm nội dung thành công và Module, chúng ta quay lại trang chủ vào 

Course để kiểm tra. 

 

* Thêm Bài tập vào khóa học 

Để xây dựng ngân hàng Bài tập cho khóa học, giảng viên chọn Course ➔ 

Assignment ➔ + Assignment sau đó trình tự nhập thông tin cần thiết theo nhu cần ➔ 

Chon Save hoặc Save & Public để hoàn tất 

 

* Thêm học viên vào khóa học 
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Sau khi người sử dụng thiết kế các khóa học phục vụ mục đích giảng dạy của 

mình thì có thể cho học viên quyền truy cập và bắt đầu khóa học. Để cho học viên 

quyền truy cập thì học viên trước hết phải có tài khoản với Canvas. 

Giảng viên sẽ lựa chọn chức năng People, nhập Email của các học viên đăng kí 

tài khoản học viên trên Canvas, rồi ấn Next. 

 

Đặt tên học viên và tiếp tục chọn Next 

 

Kiểm tra lại thông tin học viên và chọn Add Users để thêm học viên vào khóa học 

 

Ngoài ra, các bạn còn có thể thêm Học viên hàng loạt khi có sẵn Danh sách học 

viên. 

Các thành viên mới thêm sẽ có trạng thái “đang chờ xử lý”, nghĩa là đang chờ người 

học đó xác nhận tham gia khóa học. Khi nào người học xác nhận tham gia khóa học, 

dòng trạng thái tương ứng với người học đó sẽ biến mất. Việc này cho phép giảng viên 

kiểm soát được số thành viên đã tham gia khóa học. 
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* Tạo bài tập trắc nghiệm 

Để xây dựng bộ câu hỏi trắc nghiệm cho khóa học, các bạn trở về Trang chủ 

Home ➔ Course ➔ Quizzes  

 

Tại giao diện các bạn chọn + Quiz, sau đó nhập đầy đủ thông tin ở thẻ Details 

 

Sau khi nhập thông tin tại thẻ Details, các bạn chuyển qua thẻ Questions ➔ + 

New Questions để thêm nội dung bài tập trắc nghiệm mới.  

Mỗi câu hỏi trắc nghiệm có câu dẫn và các đáp án. Câu dẫn được nhập vào ô màu 

đỏ đầu tiên. Câu trả lời đúng được nhập vào ô “Correct Answer”, các đáp án tiếp theo sẽ 

được nhập vào các ô còn lại (Possible Answer)  
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Sau khi nhập đầy đủ thông tin câu hỏi và câu trả lời, các bạn chọn Update 

Questions ➔ Show Questions để kiểm tra ➔ Chọn Save hoặc Save & Public để hoàn 

tất 

 

Để kiểm tra các bạn quay về trang chủ chọn Quizzes ➔ Chọn tên bài tập trắc 

nghiệm vừa tạo ➔ Chọn Preview. Học viên sẽ chọn câu trả lời đúng và chọn Submit để 

nộp bài. 
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* Đăng thông báo đến người học 

Các bạn vào trang chủ chọn Announcements ➔ chọn + Announcements 

Announcements. 

 

Nhập các thông tin cần thiết như tiêu đề thông báo, nội dung thông báo và đối 

tượng cần thông báo ➔ chọn Save để hoàn tất thao tác, trở lại trang chủ chọn 

Announcements để kiểm tra thông báo. 

 

Như vậy, chúng tôi đã hướng dẫn các bạn các thao tác cơ bản sử dụng hệ 

thống quản lí học tập Canvas trong giảng dạy và học tập. 

 

Hướng dẫn sử dụng Canvas: 

Chi tiết tại: https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-

canvas 

   

https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-canvas
https://daotaocq.gdnn.gov.vn/camnangdttt/huong-dan-su-dung-canvas
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PHỤ LỤC 

MỘT SỐ VĂN BẢN HƯỚNG DẪN ĐÀO TẠO TRỰC TUYẾN 

BỘ LAO ĐỘNG-THƯƠNG BINH VÀ XÃ HỘI 

TỔNG CỤC GIÁO DỤC NGHỀ NGHIỆP 

 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc 

 

Số: 214/TCGDNN-ĐTCQ 

V/v đẩy mạnh ứng dụng CNTT trong tổ 

chức đào tạo và quản trị nhà trường trong 

bối cảnh dịch bệnh viêm đường hô hấp cấp 

Hà Nội, ngày 07 tháng 02 năm 2020 

   

Kính gửi:  

- Sở Lao động - Thương binh và Xã hội các tỉnh/thành phố trực 

thuộc Trung ương; 

- Các cơ sở giáo dục nghề nghiệp. 

Hiện nay, dịch bệnh viêm đường hô hấp cấp do chủng mới của virus Corona 

(nCoV) vẫn đang diễn biến phức tạp, Tổng cục Giáo dục nghề nghiệp đã có Công văn 

số 162/TCGDNN-HSSV ngày 03/2/2020 gửi các Sở Lao động - Thương binh và Xã 

hội và các cơ sở giáo dục nghề nghiệp trên cả nước tăng cường các biện pháp phòng 

chống dịch bệnh. Nhiều cơ sở giáo dục nghề nghiệp đã có thông báo cho học sinh, sinh 

viên nghỉ học để phòng tránh sự lây lan của dịch bệnh. 

Để đảm bảo công tác đào tạo và các hoạt động quản trị nhà trường không bị xáo 

trộn, ảnh hưởng đến kế hoạch hoạt động chung của hệ thống, Tổng cục Giáo dục nghề 

nghiệp đề nghị Sở Lao động - Thương binh và Xã hội các tỉnh/thành phố trực thuộc 

Trung ương chỉ đạo các cơ sở giáo dục nghề nghiệp trên địa bàn đẩy mạnh việc ứng 

dụng công nghệ thông tin và mạng xã hội trong các hoạt động quản trị nhà trường, tùy 

điều kiện về cơ sở vật chất và đội ngũ giáo viên, hướng dẫn học sinh, sinh viên sử 

dụng các công cụ, ứng dụng Internet để học tập online, học tập trực tuyến, livestream, 

E-learning… Trong trường hợp phải nghỉ học kéo dài, các trường điều chỉnh kế hoạch 

đào tạo, sử dụng quỹ thời gian dự phòng cho nghỉ hè, lễ, tết để đảm bảo thời gian và 

kết quả học tập của học sinh, sinh viên. 

Đề nghị các Sở Lao động - Thương binh và Xã hội, các cơ sở giáo dục nghề 

nghiệp cùng chung tay và chủ động áp dụng các biện pháp làm giảm thiểu tác động 

của dịch bệnh do chủng mới của virus Corona gây ra. 

Trân trọng cảm ơn! 

Nơi nhận: 

- Như trên; 

- Lãnh đạo Bộ (để b/c); 

- Tổng Cục trưởng (để b/c); 

- Lưu: VT, Vụ ĐTCQ. 

KT. TỔNG CỤC TRƯỞNG 

PHÓ TỔNG CỤC TRƯỞNG 

 

 

 

Trương Anh Dũng 
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BỘ LAO ĐỘNG-THƯƠNG BINH VÀ XÃ HỘI 

TỔNG CỤC GIÁO DỤC NGHỀ NGHIỆP 

 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc 

 

Số: 345/TCGDNN-ĐTCQ 

V/v đẩy mạnh ứng dụng CNTT trong 

tuyển sinh, tổ chức đào tạo trong bối cảnh  

dịch bệnh COVID19 

Hà Nội, ngày 21 tháng 02 năm 2020 

   

 

Kính gửi:  

- Sở Lao động - Thương binh và Xã hội các tỉnh/thành phố 

trực thuộc Trung ương; 

- Các cơ sở giáo dục nghề nghiệp. 

 

Trong bối cảnh dịch bệnh viêm đường hô hấp cấp do chủng mới của vi rút  

Corona (COVID 19) vẫn đang diễn biến phức tạp và kéo dài, để đảm bảo công 

tác tuyển sinh, tổ chức đào tạo trong năm học 2020 được thực hiện ổn định, đáp 

ứng được mục tiêu, kế hoạch theo yêu cầu, Tổng cục Giáo dục nghề nghiệp đề 

nghị các Sở Lao động - Thương binh và Xã hội, các cơ sở giáo dục nghề nghiệp 

(sau đây gọi là các trường) tăng cường các giải pháp tuyển sinh, tổ chức đào tạo 

như sau: 

1. Tiếp tục thực hiện công tác tuyển sinh, tổ chức đào tạo trong năm 2020 

theo hướng dẫn tại Công văn số 668/TCGDNN-ĐTCQ ngày 26 tháng 4 năm 

2019 của Tổng Cục trưởng Tổng cục Giáo dục nghề nghiệp hướng dẫn công tác 

tuyển sinh, tổ chức đào tạo năm 2019 theo hướng đẩy mạnh hơn nữa việc ứng 

dụng công nghệ thông tin trong tuyển sinh, tổ chức đào tạo, cụ thể: 

- Thiết lập các chuyên trang về tuyển sinh của các trường trên các trang 

mạng xã hội (facebook, twitter, viber, zalo, ....) hoặc trên các website của trường 

để thực hiện công tác truyền thông, tư vấn tuyển sinh online; đăng ký sử dụng 

dịch vụ tiếp cận đến nhiều đối tượng trên các trang mạng xã hội để dễ dàng 

trong việc tiếp cận và trao đổi thông tin tuyển sinh; 

- Xây dựng, bổ sung công cụ hỗ trợ trực tuyến (live chat) trên các website 

của trường và thường xuyên cử cán bộ, giáo viên quản lý, theo dõi nhằm kịp 

thời hỗ trợ người học trong việc tìm hiểu thông tin, tư vấn nghề nghiệp và đăng 

ký dự tuyển; 

- Đăng ký, xây dựng các chương trình truyền thông về tuyển sinh giáo dục 

nghề nghiệp của trường trên các website của các cơ quan truyền thông hoặc các 

phương tiện thông tin đại chúng ở địa phương và trung ương;  

- Xây dựng các ấn phẩm truyền thông số (sách, cẩm nang, thông tin, tranh 

ảnh, tài liệu ....) về tư vấn, hướng nghiệp; thông tin về nhà trường và hoạt động 
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đào tạo nghề nghiệp của trường để đăng tải trên các chuyên trang tuyển sinh và 

các phương tiện thông tin đại chúng; 

- Đẩy mạnh việc đăng ký dự tuyển trực tuyến qua website của nhà trường, 

Trang tuyển sinh của Tổng cục Giáo dục nghề nghiệp và Báo Tuổi trẻ (địa chỉ: 

http://tuyensinh.gdnn.gov.vn/ hoặc:  https://dangkyxettuyennghe.tuoitre.vn/); 

thực hiện việc xét tuyển và thông báo kết quả trúng tuyển trên các website của 

trường hoặc thông qua các thiết bị di động; 

- Đề nghị các Sở Lao động - Thương binh và Xã hội đặt liên kết đến địa chỉ 

Trang tuyển sinh trực tuyến của Tổng cục Giáo dục nghề nghiệp và Báo Tuổi trẻ 

trên trang thông tin điện tử của Sở (nếu có) để thuận tiện cho việc truy cập của 

người học; không tổ chức Ngày hội tư vấn tuyển sinh giáo dục nghề nghiệp trên 

địa bàn khi chưa bảo đảm an toàn trong bối cảnh dịch bệnh COVID 19. 

2. Đẩy mạnh ứng dụng công nghệ thông tin, thực hiện tốt công tác tuyển 

sinh năm 2020 theo phương châm tăng cường số lượng, nâng cao chất lượng; 

tuyển sinh gắn với tuyển dụng, việc làm sau tốt nghiệp của người học ở các trình 

độ của giáo dục nghề nghiệp; tăng cường tuyển sinh trình độ trung cấp, cao đẳng 

nhằm đáp ứng nhu cầu nhân lực lao động có tay nghề cao cả về số lượng, chất 

lượng, cơ cấu ngành, nghề và trình độ đào tạo; tiếp tục đẩy mạnh tuyển sinh đối 

tượng tốt nghiệp trung học cơ sở vào học liên thông lên trình độ cao đẳng đáp 

ứng mục tiêu phân luồng theo Quyết định số 522/QĐ-TTg ngày 14/5/2018 của 

Thủ tướng Chính phủ phê duyệt Đề án "giáo dục hướng nghiệp và định hướng 

phân luồng học sinh trong giáo dục phổ thông giai đoạn 2018 - 2025".  

Các trường theo lĩnh vực, vùng miền, nghiên cứu, thiết lập ra nhóm trường 

liên kết tuyển sinh, xây dựng Website chung để tổ chức tuyển sinh, xét tuyển 

trực tuyến; chia sẻ thông tin, dữ liệu về hồ sơ đăng ký tuyển sinh, đào tạo.  

3. Tùy từng điều kiện cụ thể, các trường nghiên cứu, điều chỉnh kế hoạch, 

chương trình đào tạo, phân công giáo viên giảng dạy cho phù hợp nếu tình hình 

dịch bệnh COVID 19 còn kéo dài, theo hướng: 

- Sử dụng thời gian dự phòng (nếu có) hoặc giảm thời gian nghỉ hè vào thời 

gian học tập chính khóa; 

- Đẩy nhanh việc số hóa các nội dung, môn học, mô đun phù hợp (ví dụ 

như các môn đun, môn học lý thuyết; các chuyên đề; các loại tài liệu giảng dạy, 

học tập...) để thực hiện đa dạng hóa các phương thức tổ chức đào tạo, đẩy mạnh 

đào tạo trực tuyến (online) đối với các nội dung, môn học, mô đun phù hợp phục 

vụ công tác giảng dạy cả trong và sau dịch bệnh COVID 19; 

- Xây dựng và phát triển hệ thống quản lý đào tạo trực tuyến, hệ thống đào 

tạo trực tuyến (E-learning); 

- Khuyến khích giáo viên nghiên cứu, ứng dụng công nghệ thông tin trong 

việc thiết kế, xây dựng các bài giảng điện tử cho nội dung, môn học, mô đun 

được phân công phụ trách và được tính vào thời gian nghiên cứu khoa học theo 

chế độ làm việc của giáo viên. 

http://tuyensinh.gdnn.gov.vn/
https://dangkyxettuyennghe.tuoitre.vn/
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- Xây dựng hệ thống liên lạc điện tử, trực tuyến với các nhóm học sinh, 

sinh viên theo khoa, khóa học... trên website của trường hoặc các trang mạng xã 

hội (live chat); thường xuyên giữ liên lạc với học sinh, sinh viên để cung cấp 

thông tin, chỉ đạo, hướng dẫn học tập; 

Mọi vấn đề cần được hỗ trợ hoặc thông tin, trao đổi, giải 

đáp trực tuyến đề nghị các Sở Lao động - Thương binh và Xã 

hội, các trường truy cập vào địa chỉ: https://zalo.me/g/ftnyfw570 

hoặc quét mã QR code như hình bên, tham gia nhóm live chat 

của Tổng cục Giáo dục nghề nghiệp để được hỗ trợ trực tuyến. 

Trên đây là một số hướng dẫn về công tác tuyển sinh, đào tạo trong bối 

cảnh dịch bệnh COVID 19, đề nghị các Sở Lao động - Thương binh và Xã hội, 

các cơ sở giáo dục nghề nghiệp nỗ lực, chủ động triển khai thực hiện, phấn đấu 

hoàn thành tốt mục tiêu, nhiệm vụ năm học 2020./. 
 

Nơi nhận: 

- Như trên; 

- Lãnh đạo Bộ (để b/c); 

- Tổng Cục trưởng (để b/c); 

- Đăng Website Tổng cục GDNN; 

- Lưu: VT, Vụ ĐTCQ. 

KT. TỔNG CỤC TRƯỞNG 

PHÓ TỔNG CỤC TRƯỞNG 

 

 

  

 

Đỗ Năng Khánh 

 

 

 

  

https://zalo.me/g/ftnyfw570
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BỘ LAO ĐỘNG-THƯƠNG BINH VÀ XÃ HỘI 

TỔNG CỤC GIÁO DỤC NGHỀ NGHIỆP 

 

CỘNG HOÀ XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập - Tự do - Hạnh phúc 

 

Số: 587/TCGDNN-ĐTCQ 

V/v hướng dẫn ứng dụng CNTT  

trong tổ chức đào tạo trước bối cảnh  

dịch bệnh COVID-19 

Hà Nội, ngày 17 tháng 03 năm 2020 

   

 

Kính gửi: Các trường trung cấp, trường cao đẳng 

Tiếp theo Công văn số 214/TCGDNN-ĐTCQ ngày 07/02/2020 và Công 

văn số 345/TCGDNN-ĐTCQ ngày 21/02/2020 của Tổng cục Giáo dục nghề 

nghiệp, về việc đẩy mạnh ứng dụng công nghệ thông tin (CNTT) trong tuyển 

sinh, đào tạo trong bối cảnh dịch COVID-19; để ứng phó với tình hình dịch bệnh 

vẫn đang diễn biến phức tạp, Tổng cục Giáo dục nghề nghiệp hướng dẫn các 

trường trung cấp, trường cao đẳng (sau đây gọi là các trường) thực hiện một số 

giải pháp đẩy mạnh ứng dụng công nghệ thông tin (CNTT) trong đào tạo như 

sau: 

1. Khuyến khích đầu tư, xây dựng hệ thống đào tạo trực tuyến chuyên 

nghiệp bao gồm việc học tập trực tuyến (e-learning), hệ thống quản lý học tập 

trực tuyến (LMS - Learning Management System), hệ thống quản lý nội dung 

học tập (LCMS - Learning Content Management System) bằng các giải pháp 

công nghệ mã nguồn mở như Blackboard, Moodle, Canvas.v.v… phục vụ cho cả 

mục tiêu đào tạo trước mắt và lâu dài. 

2. Trong khi chưa có các hệ thống đào tạo trực tuyến chuyên nghiệp, khẩn 

trương xây dựng, tổ chức đào tạo trực tuyến với những nội dung, môn học 

chung; nội dung, môn học lý thuyết bằng việc khai thác, ứng dụng triệt để các 

chương trình, ứng dụng hiện có trên Internet, trong đó tập trung nghiên cứu, áp 

dụng một số chương trình, ứng dụng sau (đây là một số chương trình đã được 

một số trường áp dụng thành công): 

a) Chương trình Zoom Cloud Meeting của Zoom Video Communications, 

Inc (địa chỉ tại: https://www.zoom.us/ là chương trình dùng để hội họp hoặc học 

tập trực tuyến trực tiếp (Face to Face). Giáo viên trực tiếp tương tác với học 

sinh, sinh viên (HSSV) tham gia lớp học thông qua máy tính, thiết bị di động có 

kết nối internet. Ưu điểm của Chương trình: 

- HSSV nhìn và nghe được giáo viên giảng bài; giáo viên trao đổi được với 

cả lớp, trao đổi được với cả lớp và trao đổi riêng với từng HSSV; 

- Chia sẻ nội dung học tập trên màn hình trên máy tính (text, sơ đồ, hình 

ảnh….); bảng trắng cho thuyết trình, trình chiếu file PowerPoint; 

- Sử dụng gọi video trực tuyến; chất lượng hội thoại tốt, ổn định; ghi âm, 

ghi hình lại toàn bộ buổi học; 

https://www.zoom.us/
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- Giao diện thân thiện, dễ sử dụng và miễn phí với gói cơ bản (Basic) 

nhưng cũng đầy đủ các tính năng nêu trên. 

(Xem hướng dẫn cài đặt và sử dụng Zoom Cloud Meeting trên Internet) 

b) Chương trình Hangouts Meet của Google cũng có chức năng tương tự 

như Zoom Cloud Meeting, là chương trình học trực tuyến trực tiếp qua mạng 

trên nền web được tích hợp trong bộ G-suite của Google (địa chỉ: 

https://meet.google.com). Ưu điểm của Chương trình: 

- Cho phép chia sẻ link để nhiều người học mà không cần cài đặt (không 

cần phần mềm tải xuống); 

- Số lượng người tham gia tối đa lên đến 100 người và không giới hạn thời 

gian cuộc gọi (Zoom Cloud Meeting giới hạn 40 phút ở gói Basic); 

- Dễ sử dụng dữ liệu từ các ứng dụng khác của Google như Google 

Classroom; 

- Tính năng ghi hình buổi học và lưu trữ trên Google Drive; 

- Dễ sử dụng và hoàn toàn miễn phí đối với cơ sở giáo dục. 

(Xem thêm hướng dẫn cài đặt và sử dụng Hangouts Meet trên Internet) 

c) Ứng dụng Microsoft Teams trong Chương trình Office 365 của 

Microsoft là một công cụ để quản lý, tổ chức đào tạo trực tuyến gián tiếp, đảm 

bảo HSSV tiếp thu kiến thức một cách tốt nhất thông qua website, máy tính và 

điện thoại (địa chỉ: https://www.microsoft.com/vi-vn/education/products/teams). 

Ứng dụng này có thể kết hợp luôn với tiện ích Meet now của Office hoặc phối 

hợp với chương trình Zoom Cloud Meeting hoặc Hangouts Meet của Google 

nêu trên để có được giải pháp hoàn thiện cả trực tiếp và gián tiếp về tổ chức đào 

tạo trực tuyến. Ưu điểm của Ứng dụng:   

- Giáo viên và HSSV có thể cùng soạn tài liệu, bài tập và chia sẻ tài nguyên 

với nhiều các ứng dụng tích hợp trong Office 365 (Word, Excel, 

PowerPoint.v.v…); 

- Tạo các bài tập, các bài kiểm tra thiết thực, hướng dẫn rõ ràng và phản hồi 

phong phú với tiện ích Microsoft Form; 

- Trực tiếp sắp xếp và theo dõi bài tập và điểm số của học sinh mỗi lớp từ 

một nhóm lớp; 

- Sử dụng miễn phí cho toàn trường, chỉ cần xác minh trường là một tổ 

chức giáo dục chính quy (có tài khoản dạng .edu.vn và đăng ký với Microsoft). 

(Xem thêm hướng dẫn sử dụng Microsoft Teams trên Internet) 

d) Chương trình Google Classroom là một dịch vụ web miễn phí của 

Google, công cụ giúp giáo viên tổ chức và quản lý lớp học dễ dàng, quản lý việc 

kiểm tra, đánh giá kết quả học tập của HSSV (địa chỉ: 

https://classroom.google.com). Chương trình này có thể sử dụng cùng với 

chương trình Hangouts Meet của chính Google hoặc phối hợp với chương trình 

Zoom Cloud Meeting để tổ chức đào tạo trực tuyến. Ưu điểm của Chương trình: 

- Tích hợp với các tiện ích của Google, giúp đơn giản hóa công việc quản 

lý giảng dạy, kiểm tra, đánh giá; 

https://meet.google.com/
https://www.microsoft.com/vi-vn/education/products/teams
https://classroom.google.com/
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- Giáo viên và HSSV có thể theo dõi, cập nhật tình hình lớp học ở bất kỳ 

nơi đâu (chỉ cần có máy tính, thiết bị di động có kết nối internet). 

- Quản lý kết quả học tập của HSSV; các thông báo tức thời và các trao đổi 

trên diễn đàn được thực hiện dễ dàng; 

- Dễ sử dụng và hoàn toàn miễn phí. 

(Xem thêm hướng dẫn cài đặt và sử dụng Google Classroom trên Internet) 

đ) Ngoài ra, trên Internet hiện nay còn nhiều các chương trình, ứng dụng 

khác như Skype của Microsoft, Meet now của Office, Gotomeeting của 

LogMeIn, TrueConf Online của TrueConf LLC.v.v… là các ứng dụng cũng có 

thể thực hiện tổ chức đào tạo trực tuyến. 

3. Để triển khai thực hiện được các chương trình, ứng dụng đào tạo trực 

tuyến nêu trên, đề nghị các trường: 

a) Thành lập nhóm triển khai đào tạo trực tuyến với thành phần chính là cơ 

quan đào tạo và bộ phận công nghệ thông tin của trường; 

b) Xây dựng kế hoạch tổ chức đào tạo trực tuyến trong đó xác định rõ các 

nội dung cần phải thực hiện như:  

- Xác định các nội dung, môn học lý thuyết để có thể tổ chức đào tạo trực 

tuyến (các môn học chung, các nội dung, hoặc môn học/học phần lý thuyết cơ 

sở, lý thuyết chuyên môn…); 

- Xây dựng kế hoạch thực hiện chi tiết; lập thời khóa biểu cho việc giảng 

dạy trực tuyến; 

- Phân công giáo viên phụ trách/giảng dạy để chuẩn bị nội dung bài giảng; 

các điều kiện lớp học, kết nối với HSSV. 

c) Tổ chức biên soạn tài liệu hướng dẫn sử dụng cho giáo viên và HSSV; 

tập huấn sử dụng chương trình, ứng dụng và cách thức thực hiện đào tạo trực 

tuyến cho giáo viên; 

d) Hỗ trợ các điều kiện về cơ sở vật chất, thiết bị (phòng học trực tuyến, 

máy tính có trang bị camera, microphone; máy chụp ảnh, quay phim,….) cho 

các khoa chuyên môn và giáo viên giảng dạy trực tiếp (nếu có); 

đ) Xây dựng quy chế đào tạo trực tuyến, quy định rõ quyền và trách nhiệm 

của giáo viên, HSSV trong đào tạo trực tuyến để bảo đảm tiến độ, chất lượng 

đào tạo theo yêu cầu; 

e) Việc tổ chức đào tạo, kiểm tra đánh giá kết quả học tập của HSSV được 

thực hiện theo quy định tại Thông tư số 33/2018/TT-BLĐTBXH ngày 26 tháng 

12 năm 2018 của Bộ trưởng Bộ Lao động - Thương binh và Xã hội ban hành 

Quy định về đào tạo trình độ cao đẳng, trung cấp, sơ cấp theo hình thức đào tạo 

từ xa, tự học có hướng dẫn và Thông tư số 09/2017/TT-BLĐTBXH ngày 13 

tháng 3 năm 2017 của Bộ trưởng Bộ Lao động - Thương binh và Xã hội quy 

định về tổ chức thực hiện chương trình đào tạo trình độ trung cấp, trình độ cao 

đẳng theo niên chế hoặc theo phương thức tích lũy mô - đun hoặc tín chỉ; quy 

chế kiểm tra, thi, xét công nhận tốt nghiệp; 

g) Thời gian giảng dạy trực tuyến bao gồm: Thời gian giảng dạy trực tiếp 

(có thể thực hiện trên Zoom Cloud Meeting hoặc Hangouts Meet) và thời gian 
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giảng dạy gián tiếp bằng việc trao đổi, giải đáp thắc mắc và giao bài tập cho 

HSSV (có thể thực hiện trên Microsoft Teams hoặc trên Google Classroom) và 

được tính khối lượng giảng dạy như lớp học truyền thống. Một ngày học trực 

tuyến không nên quá 5 giờ (45 phút/giờ), trong đó mỗi giờ học có tối thiểu từ 20 

- 30 phút giảng dạy trực tuyến trực tiếp (trên Zoom Cloud Meeting hoặc 

Hangouts Meet), thời gian còn lại để trao đổi, giải đáp thắc mắc, giao bài tập cho 

HSSV (trên Microsoft Teams hoặc trên Google Classroom) và nghỉ giải lao.  

h) Thời gian học tập và các hoạt động trong một ngày học trực tuyến có thể 

thực hiện linh hoạt tùy thuộc vào điều kiện và hoàn cảnh thực tế của từng trường 

do hiệu trưởng quyết định. Trường hợp việc truy cập internet của HSSV không 

ổn định thì không thực hiện giảng dạy trực tuyến trực tiếp (trên Zoom Cloud 

Meeting hoặc Hangouts Meet). Giáo viên thực hiện giảng dạy trực tuyến gián 

tiếp bằng việc tải dữ liệu bài giảng (video, tài liệu giảng dạy, học tập, tham 

khảo.v.v..) lên các lớp học trực tuyến (Microsoft Teams hoặc trên Google 

Classroom) và giao nhiệm vụ cho HSSV thực hiện. 

i) Thường xuyên, định kỳ kiểm tra, đánh giá việc triển khai thực hiện đào 

tạo trực tuyến trong trường để kịp thời điều chỉnh, rút kinh nghiệm, cải thiện, 

nâng cao chất lượng đào tạo trực tuyến; 

k) Báo cáo việc tổ chức đào tạo trực tuyến tại trường về Tổng cục Giáo dục 

nghề nghiệp (qua Vụ Đào tạo chính quy) đối với trường cao đẳng và về Sở Lao 

động - Thương binh và Xã hội địa phương đối với trường trung cấp để theo dõi, 

quản lý, sau khi đã tổ chức đào tạo trực tuyến; 

l) Tiếp tục duy trì, kết hợp giữa đào tạo trực tuyến với đào tạo truyền thống 

khi HSSV đi học trở lại; xây dựng, phát triển hệ LMS chuyên nghiệp của trường 

kết hợp với các chương trình, ứng dụng đã triển khai. 

Mọi vấn đề cần được hỗ trợ hoặc thông tin, trao đổi, giải đáp trực tuyến đề 

nghị các trường truy cập vào địa chỉ Website: https://daotaocq.gdnn.gov.vn và 

tham gia Diễn đàn trên Website để được hỗ trợ. 

Trên đây là một số hướng dẫn ứng dụng CNTT trong tổ chức đào tạo trước 

bối cảnh  dịch bệnh COVID-19, đề nghị các trường tích cực, chủ động triển khai 

thực hiện./. 

Nơi nhận: 

- Như trên; 

- Lãnh đạo Bộ (để b/c); 

- Lãnh đạo Tổng cục (để b/c); 

- Các Sở LĐTB&XH (để p/h chỉ đạo); 

- Đăng Website Tổng cục GDNN; 

- Lưu: VT, Vụ ĐTCQ. 

TL. TỔNG CỤC TRƯỞNG 

VỤ TRƯỞNG VỤ ĐÀO TẠO CHÍNH QUY 

 
 

 

  

Vũ Xuân Hùng 
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